hp business inkjet
1100d • 1100dtn

user’s guide
Copyright Information

© 2003 Copyright Hewlett-Packard Development Company, LP
Reproduction, adaptation or translation without prior written permission is prohibited, except as allowed under the copyright laws.
Edition 1, 9/2003

Notice
The information contained herein is subject to change without notice.
The only warranties for HP products and services are set forth in the express warranty statements accompanying such products and services. Nothing herein should be construed as constituting an additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.
No part of this document may be photocopied, reproduced, or translated to another language without the prior written consent of Hewlett-Packard Company.

Trademark Credits
Microsoft®, Windows®, Windows NT®, and MS-DOS® are U.S. registered trademarks of Microsoft Corporation.
UNIX® is a registered trademark of the Open Group.
Novell® and NetWare® are registered trademarks of Novell Corporation.
Pentium® is a registered trademark of Intel Corporation.
Adobe® and Acrobat® are registered trademarks of Adobe Systems Incorporate.

Safety Information

Always follow basic safety precautions when using this product to reduce risk of injury from fire or electric shock.
1. Read and understand all instructions in the documentation that comes with the printer.
2. Use only a grounded electrical outlet when connecting this product to a power source. If you do not know whether the outlet is grounded, check with a qualified electrician.
3. Observe all warnings and instructions marked on the product.
4. Unplug this product from wall outlets before cleaning.
5. Do not install or use this product near water, or when you are wet.
6. Install the product securely on a stable surface.
7. Install the product in a protected location where no one can step on or trip over the line cord, and the line cord cannot be damaged.
8. If the product does not operate normally, see “Maintaining and troubleshooting”.
9. There are no user-serviceable parts inside. Refer servicing to qualified service personnel.
Contents

Getting started
Finding other resources for product information .......................................................... 1-1
Learning about printer configurations ............................................................................. 1-2
Understanding the printer parts and functions ............................................................... 1-3
Connecting the printer ..................................................................................................... 1-6
  Connecting directly using a USB or parallel cable (Windows) ........................................... 1-6
  Sharing the printer on a locally shared network (Windows) ........................................... 1-9
  Connecting directly using a USB cable (Mac OS) .......................................................... 1-10
  USB printer sharing over an Ethernet network (Mac OS) ................................................. 1-11
  Connecting to a network ................................................................................................... 1-12
  Installing software for a network printer on a Macintosh ................................................. 1-14
Uninstalling the printing system software ....................................................................... 1-15
Uninstalling software for Windows (all versions) .............................................................. 1-15
Uninstalling software for Macintosh (all versions) ............................................................ 1-16
Using the embedded Web server ...................................................................................... 1-16
Making copies of the software .......................................................................................... 1-17
Installing other software .................................................................................................. 1-17

Using the printer
Selecting print media ........................................................................................................ 2-1
  Understanding specifications for supported media ......................................................... 2-2
  Setting minimum margins ............................................................................................... 2-4
Loading media .................................................................................................................. 2-5
Configuring trays .............................................................................................................. 2-7
  Setting the tray lock ...................................................................................................... 2-8
  Selecting a default tray .................................................................................................. 2-8
  Understanding default tray behavior for the Mac OS ...................................................... 2-9
Printing using the PCL 3 printer driver ............................................................................ 2-9
Changing printer settings .................................................................................................. 2-10
  Changing settings for Windows ...................................................................................... 2-10
  Changing settings for the Mac OS .................................................................................. 2-11
Performing printer tasks .................................................................................................... 2-12
  Canceling a print job .................................................................................................... 2-12
  Printing on both sides (duplexing) ................................................................................ 2-12
  Performing automatic duplexing ................................................................................... 2-13
  Performing manual duplexing ...................................................................................... 2-14
  Printing photographs .................................................................................................... 2-15
Printing on special media ................................................................................................ 2-16
  Printing on envelopes and cards ..................................................................................... 2-16
  Printing on transparencies ............................................................................................. 2-18
  Printing on custom-size media ...................................................................................... 2-19

Using diagnostic tools
Using the Toolbox .............................................................................................................. 3-1
  Printer Status tab .......................................................................................................... 3-1
  Information tab ............................................................................................................... 3-2
  Printer Services tab ........................................................................................................... 3-2
Using hp instant support .................................................................................................. 3-3
Using myPrintMileage ...................................................................................................... 3-4
Using the HP Inkjet Utility ............................................................................................... 3-5
Using HP Web Jetadmin ................................................................................................... 3-6
Using the deskjet control panel (DJCP) .......................................................................... 3-6
Maintaining and troubleshooting

Maintaining ink cartridges and printheads ................................................................. 4-1
  Replacing ink cartridges ......................................................................................... 4-1
  Checking the printheads ......................................................................................... 4-3
  Cleaning the printheads ......................................................................................... 4-3
  Cleaning the printhead contacts ............................................................................ 4-5
  Aligning the printheads ......................................................................................... 4-7
  Replacing the printheads ....................................................................................... 4-8
Calibrating color ......................................................................................................... 4-10
Clearing jams ............................................................................................................... 4-11
Starting troubleshooting ............................................................................................. 4-13
Printing a configuration page ...................................................................................... 4-14
Resolving printer problems ....................................................................................... 4-15
  Printer shuts down unexpectedly ............................................................................ 4-15
  Printer is not responding (nothing prints) ................................................................. 4-15
  All lights are blinking .............................................................................................. 4-16
  Printer takes a long time to print ............................................................................ 4-16
Resolving printing problems ....................................................................................... 4-17
  A blank page printed .............................................................................................. 4-17
  Something on the page is missing or incorrect ......................................................... 4-17
  Placement of the text or graphics is wrong ............................................................... 4-18
  Poor print quality .................................................................................................... 4-19
Resolving paper-feed problems .................................................................................. 4-22
  Tray cannot be inserted ......................................................................................... 4-22
  Another paper-feed problem is occurring ............................................................... 4-22
Troubleshooting installation issues ............................................................................ 4-23

Printer lights reference

HP supplies and accessories

Ordering printing supplies through the Toolbox .......................................................... A-1
Finding accessory part numbers ................................................................................ A-1
Finding supplies part numbers .................................................................................. A-2

Support and warranty

Toolbox ......................................................................................................................... B-1
hp instant support ....................................................................................................... B-1
Web .............................................................................................................................. B-1
HP telephone support ................................................................................................ B-2
Hewlett-Packard limited warranty statement ............................................................... B-3

Printer specifications

Regulatory information

FCC statement .............................................................................................................. D-1
EMI statement (Korea) ................................................................................................. D-2
Regulatory model number ......................................................................................... D-2
Power cord statement ................................................................................................. D-2
LED classification ....................................................................................................... D-2
Energy consumption .................................................................................................... D-2
Declaration of Conformity ........................................................................................... D-3

Glossary

Index
Thank you for buying the printer. This guide provides details about how to set up your computer, how to perform simple printer tasks, and how to resolve printer problems.

Finding other resources for product information

You can obtain product information that is not included in this guide from the following resources:

- **Setup poster.** Provides illustrated setup information. A printed version of this document is provided with the printer. Also, an electronic version is available as an Adobe Acrobat Portable Document Format (PDF) file on the Starter CD.
- **Getting started guide.** Includes information about setting up the printer and installing the software. You probably referred to this guide when you set up the product.
- **Online Help.** Includes overview information about and procedures performed using the printer software.
- **Starter CD.** Includes the printer driver, Toolbox, Installer Customization utility, electronic copies of this user’s guide, release notes, and ordering information.
- **Toolbox.** Contains “how-to” and troubleshooting instructions, and provides information about printhead health. If you choose to install the Toolbox, a Toolbox taskbar icon appears when the Toolbox is running. Toolbox is available for Microsoft Windows users only.
- **hp instant support.** A Web-based tool that provides product-specific services, troubleshooting tips, and information about your printer’s ink and media usage. This e-service can be opened from the Toolbox. hp instant support is available for Windows users only.
- **HP Inkjet Utility.** The HP Inkjet Utility contains tools to calibrate the printer, clean the printheads, print a test page, set tray lock, and find website support information. The HP Inkjet Utility is available for Mac OS 8.6, 9.x, and OS X users only.
- **World Wide Web.** The following websites contain information about the printer:
  - [http://www.hp.com/support/businessinkjet1100](http://www.hp.com/support/businessinkjet1100)
  - [http://www.hp.com](http://www.hp.com)
- **HP Jetdirect Print Server Administrator’s Guide.** Included on the Starter CD, it provides detailed information about setting up and using your HP Jetdirect print server. It also provides information about these topics:
  - Troubleshooting and HP Jetdirect configuration page messages
  - HP Software Solutions for HP Jetdirect print servers
  - TCP/IP configuration
  - Using LPD (Line Printer Daemon) services on the HP Jetdirect print server
  - FTP (file transfer protocol) printing
- **HP Jetdirect setup manual.** This manual is included with the purchase of an HP Jetdirect print server. It describes the setup and configuration of your HP Jetdirect print server. Note that the HP Jetdirect setup manual does not come with the printer.
- **Network operating system (NOS) and operating system (OS) manuals.** These manuals came with your computer or your NOS. They describe the basic network printing common to all network printers.
Learning about printer configurations

This printer is a four-color Inkjet printer that prints up to 23 pages per minute (ppm) in monochrome (black and white) and 6 ppm in color in Draft mode. The laser-quality speed is 4.5 ppm for black text and 3 ppm for mixed text color. (Laser-quality speed is the print speed that can be expected in relation to the pages-per-minute speed of laser printers.)

**HP Business Inkjet 1100d**

The printer includes these features.

- **Paper handling.** This model includes a standard input tray (Tray 1) that holds up to 150 sheets. It also includes an auto-duplex unit for printing two-sided documents, which saves money and paper.
- **Connectivity.** In North America, this model includes a USB connector, and you can add an optional parallel connector. In the rest of the world, this model includes a USB connector and a parallel connector.

You can add these optional accessories to the printer.

- Add an optional second paper tray (Tray 2), which holds 250 sheets, for greater flexibility in the types and quantity of media you can have loaded.
- Add an optional print server to allow two or three users to share the printer easily on a network. However, only a parallel connector or a print server can be installed.
- In North America, add an optional parallel connector if you want to connect the printer to a computer using a parallel cable. However, only a parallel connector or a print server can be installed.

**HP Business Inkjet 1100dtn**

The printer includes these features.

- **Paper handling.** This model includes a standard input tray (Tray 1), which holds up to 150 sheets, and Tray 2, which holds 250 sheets for a total capacity of 400 sheets. It also includes an auto-duplex unit, which saves money and paper.
- **Connectivity.** This model contains a USB connector and an HP Jetdirect 200m print server to allow multiple users to share the printer easily on a network.
Understanding the printer parts and functions

Front view

1. Paper guides.
2. Output tray.
3. Control panel. See “Control panel parts”.
4. Top cover.
5. Printing supplies cover. See “Printing supplies area”.
6. Tray 2. This 250-sheet tray is included with the HP Business Inkjet 1100dtn model; available as an accessory for the HP Business Inkjet 1100d.
7. Tray 1. This tray holds 150 sheets.
9. Envelope slot. Use this slot to feed one envelope at a time.
Printing supplies area

1 **Printhead latch.** The printhead latch provides access for installing or removing printheads from their color-coded slots.

2 **Printheads.** Each printhead must be placed in its color-coded slot.

3 **Ink cartridges.** Each ink cartridge must be placed in its color-coded slot.

4 **Metal catch bar.** The metal catch bar secures the hook and engages the printhead latch.

Control panel parts

1 (power button).

2 Power light (green).

3 **Printing supplies lights.** Indicate the status of ink cartridges and printheads: a) Printhead light b) Ink Cartridge light c) color indicator lights. See "Printer lights reference".

4 (cancel button). Cancels the current print job.

5 (resume button).

6 **Resume light.** This light blinks in these situations:
   • when there is a media jam
   • when the printer is out of paper
   • while a printed page is drying
   • while the printer is printing a manual duplex job and waiting for the job to be turned

If the printed page is drying, then wait for the printer to finish, and the light will turn off. Otherwise, resolve the problem and press the (resume button) if the light does not turn off.
Back view

1 **USB connector.**

2 **Connection slot.** This slot holds the HP Jetdirect print server for networking (included with the HP Business Inkjet 1100dtn) or a parallel connector.

3 **Power input.**

4 **Auto-duplex unit.** Unit that provides automatic printing on both sides of a sheet of paper.
Connecting the printer

Your printer supports local printing and network printing. For local printing, you can connect the printer using a USB cable, or a parallel cable if you have a parallel connector installed. (USB cables or parallel cables are sold separately. To order, see “HP supplies and accessories”.)

You can share the printer in these ways:

- You can use a simple form of networking, known as locally shared networking, if you used a parallel cable or USB cable to connect the printer to a computer running Windows. Using this method, you can share the printer with other Windows users. See “Connecting directly using a USB or parallel cable (Windows)” and “Sharing the printer on a locally shared network (Windows)”.
- You can also use locally shared networking if you used a USB cable to connect the printer to a computer running a Mac OS. Using this method, you can share the printer with other Mac OS users. See “Connecting directly using a USB cable (Mac OS)”.
- For true network printing, you can connect using an optional HP print server. (The HP Jetdirect 200m print server is included with the HP Business Inkjet 1100dtn.) This method of printing allows both users of Windows and Mac OS to print. See “Connecting to a network”.

Connecting directly using a USB or parallel cable (Windows)

In the Windows environment, you can connect directly using either a USB cable or a parallel cable.

**Note**

Do not connect a USB and a parallel cable to printer at the same time.

To use a USB cable to connect the printer to a computer running a Mac OS, see “Connecting directly using a USB cable (Mac OS)”.

- **USB connection**
  For Windows, you can use a USB cable to connect the printer to the computer if the computer has a USB port and is running Microsoft Windows 98, Me, 2000, or XP. (Windows NT does not support USB.) If your computer does not meet these specifications, connect the printer to your computer using a parallel connector or a print server (if the printer has one of these two).

  In most cases, after you install the printer software and connect a printer to the computer, you can install additional printers with USB cables without reinstalling the printing software.

- **Parallel connection**
  You can connect the printer to the parallel port, if you have one. The computer must have a parallel port and must be running Windows.
It is recommended that you do a software-first installation. See “Completing a software-first installation (recommended)”. Only do a hardware-first installation if you already connected the cable and started the software. See “Completing a hardware-first installation”.

Completing a software-first installation (recommended)

Complete the setup using these instructions if you have not yet installed a USB or parallel cable (not included). This method is the preferred one.

To complete a software-first installation

1 Close any running applications.
   a Press CTRL+ALT+DELETE simultaneously on your computer keyboard and then click Task Manager.
   b Close any applications that are running. (Do not close Systray or Explorer.)
   c When finished, click the X in the upper-right corner of the Task Manager to close it.

2 Insert the Starter CD into the CD drive. The CD menu runs automatically.
   If the CD menu does not run automatically, click Start, click Run, and in the command line box, type the letter of your computer’s CD drive followed by \SETUP (for example, type D:\SETUP).

3 On the CD menu, click Install Printer Driver.

4 Choose the language you want and click OK.

5 Follow the instructions on the screen.

6 When prompted, click Connected directly to this computer, and then click Next.

7 Do one of the following:
   • For USB connection: Click USB Cable and then click Next.
• For parallel connection: Click **Parallel Cable** and use the drop-down menu to select the parallel port to which the printer is connected (usually LPTs). If the installation program detects that the printer is already connected to the computer using a parallel cable, you can install the printer using the same port. In addition, if the **Express Install** check box is selected, the installation program uses the default settings.

8  Follow the instructions on the screen to complete the installation.

9  When prompted, connect the USB or parallel cable to the computer and the printer. The **Found New Hardware** wizard appears on the computer screen and the printer icon is created in the Printers folder.

10 To share the printer, see “Sharing the printer on a locally shared network (Windows)”.

### Completing a hardware-first installation

Complete the setup using these instructions if you already installed a USB or parallel cable (not included) and then started the software. The **Found New Hardware** screen appears.

**To complete a hardware-first installation**

<table>
<thead>
<tr>
<th>Note</th>
<th>Before you can install the printer software on a computer running Windows XP 64-bit, you must download the printer software from <a href="http://www.hp.com/support/businessinkjet1100">http://www.hp.com/support/businessinkjet1100</a>.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Click <strong>Next</strong> in the <strong>Found New Hardware</strong> wizard.</td>
</tr>
<tr>
<td>2</td>
<td>Click <strong>Search for the best driver for your device (Recommended)</strong>, and then click <strong>Next</strong>.</td>
</tr>
<tr>
<td>3</td>
<td>Insert the Starter CD into the CD-ROM drive.</td>
</tr>
<tr>
<td>4</td>
<td>If the CD menu appears, click <strong>Exit</strong> twice to close the CD menu.</td>
</tr>
<tr>
<td>5</td>
<td>Select <strong>Specify a location</strong>.</td>
</tr>
<tr>
<td>6</td>
<td>Click <strong>Browse</strong> to locate the root directory on the Starter CD, and then click <strong>OK</strong>.</td>
</tr>
<tr>
<td>7</td>
<td>Click <strong>Next</strong>, and then follow the instructions on the screen.</td>
</tr>
<tr>
<td>8</td>
<td>Click <strong>Next</strong>, and then click <strong>Finish</strong>.</td>
</tr>
</tbody>
</table>
| 9    | To share the printer, see “Sharing the printer on a locally shared network (Windows)”.

**Note**

Upon completion of the hardware-first installation process, the Found New Hardware wizard will automatically launch the setup program. This gives you the option to install non-driver components such as the Toolbox.
Sharing the printer on a locally shared network (Windows)

In a locally shared network, the printer is connected directly to the USB or parallel connector of a selected computer (known as the server) and is shared by other computers (clients). Use this configuration only in small groups or when usage is low. The computer connected to the printer is slowed down when many users print to its shared printer.

You can share the printer on a locally shared network when:

- The computer connected to the printer is running Windows.
- The printer will be shared with other Windows users. (You cannot share the printer with Mac OS users.)

Sharing a printer connected to your computer (the server)

1. From the Start menu, find the Printers folder. (The route is different for different Windows operating systems. It might be through Settings or Control Panel, or directly through Printers and Faxes.)
2. In the Printers folder, right-click the printer and click Properties.
3. On the Share tab, select the “share the printer” option, give the printer a Share Name.
4. Optional. If you are sharing the printer with users of other versions of Windows, you can click Additional Drivers to install their drivers as a convenience to them. This step requires you to have the Starter CD in your CD drive.

Note

When sharing a locally connected printer, use the newest operating system as the server. A Windows 98 server will not recognize a Windows 9000 client.

5. Click OK.

Using a printer connected to another computer (clients)

Clients can connect to the printer in three different ways:

- Install the printer software from the Starter CD. When prompted, select Connected via the network, and then select Client Setup for client-server printing.
- Browse to the printer on the network and drag the printer to your Printers folder.
- Add the printer and install the software from the INF file that has been saved to a location on your network. Ask the network administrator where the INF file is located.

On the Starter CD, the INF files are stored in folders using the following format:

<CD>:\Setup\Drivers\PCL3\<operating system>\<language>.

For example, if your CD drive letter is D:, then D:\Setup\Drivers\PCL3\Win2k_XP\English would contain the English Windows 2000 PCL 3 INF file.
Connecting directly using a USB cable (Mac OS)

Install the software first, and then connect the printer to the computer. You can share the printer with other Mac OS users when you are finished, if you want.

To connect using a USB cable

1 Insert the Starter CD into the CD-ROM drive. The CD menu runs automatically. If the CD menu does not run automatically, double-click the CD icon on the desktop, and then double-click the Setup icon.
2 Click Install Driver.
3 Follow the instructions on the screen.
4 Connect the cable between the connectors on the computer and the printer.
5 Complete the installation in one of these ways.
   - Mac OS 8.6 to Mac OS 9.x: See “To finish installing for Mac OS 8.6 to Mac OS 9.x” below.
   - Mac OS X or later: See “To finish installing for Mac OS X and later” below.

To finish installing for Mac OS 8.6 to Mac OS 9.x

1 When prompted, restart the computer.
2 Select Chooser from the Apple menu.
3 Select hp deskjet xx in the upper left window of the Chooser window, where xx represents the version of the current printer driver.
4 Select hp business inkjet 1100 in the right window of the Chooser screen.
5 Close the Chooser.
6 To share the printer, see “USB printer sharing over an Ethernet network (Mac OS)”.

To finish installing for Mac OS X and later

1 Open the Print Center, which is located in the Applications\Utilities folder.
2 Click Add.
3 Select USB from the menu.
4 Select hp business inkjet 1100 from the printer list, and then click Add. A dot appears beside the printer name, indicating that this printer is now the default printer.
5 Close the Print Center.
6 To share the printer, see “USB printer sharing over an Ethernet network (Mac OS)”.
USB printer sharing over an Ethernet network (Mac OS)

Basic requirements for printer sharing in a Macintosh environment include the following:

- The Macintosh computers must be communicating on the network using TCP/IP, and the Macintosh computers must have IP addresses. (AppleTalk is not supported.)
- The printer being shared must be connected to a built-in USB port on the host Macintosh computer.
- Both the host computer and the client computers that are using the shared printer must have printer sharing software installed and the printer driver or PPD for the printer that is installed. (You can run the Installer program to install the printer sharing software and associated Help files.)
- The client computers should have the appropriate HP printer drivers installed.
- The client computers must be PowerMac computers.
- To use a shared USB PostScript printer, the client computers must have a USB port.

For more information about USB printer sharing, see the support information available on the Apple website (http://www.apple.com) or the Mac Help on the computer.

Sharing among Mac computers with the same operating system

Enable printer sharing on the computer that is connected to the printer (the host).

- Mac OS 8.6 to 9.x: Open Control Panels, and then click USB Printer Sharing.
- Mac OS X: Open System Preferences, click Sharing, click Services, and then click the Printer Sharing check box (Mac OS X v 10.2.4).

To print from the other Macintosh computers (the clients) on the network, preselect the printer in USB Printer Sharing (Mac OS 8.6 to 9x) or Sharing (Mac OS X). Then, choose the neighborhood where the printer is shared and select the printer.

Sharing among Macintosh computers with different operating systems

Use the following steps to share a printer with Mac OS 8.6 to 9.x computers when the host computer is running Mac OS X.

Note

USB printers cannot be shared between Mac OS 9 and Mac OS X operating systems except through the Classic environment in Mac OS X.

1. On the Max OS X host computer, open System Preferences, make sure that printer sharing is off, and then quit System Preferences.
2. Locate the Mac OS 9 System folder, open Control Panel, and then open USB Printer Sharing. (If the Classic environment is not already running, it starts.)
3. Click the Start/Stop tab, and then click Start.
4. When "USB Printer Sharing On" appears, click the My Printers tab.
5. Select the check box next to the printer that you want to share.
6. Close the control panel.
Connecting to a network

Your printer can be shared in a network environment by connecting it directly to a network via an optional HP Jetdirect print server. (One is included with the HP Business Inkjet 1100dtn.) This configuration provides better performance than printing through a computer, flexibility in preparing a location for the printer, and the ability to share the printer with both Windows and Mac OS users.

For all operating systems, start by installing the print server card. See “Installing the HP Jetdirect internal print server card”.

Installing the HP Jetdirect internal print server card

The HP Business Inkjet 1100dtn comes with an HP Jetdirect print server 200m. To purchase an internal HP Jetdirect print server for the HP Business Inkjet 1100d, see “Network interfaces”.

The print server comes with factory default settings. If you need to configure the print server after the printer software has been installed, see the HP Jetdirect Print Server Administrator’s Guide. This guide is available on the Starter CD. It can also be downloaded from the HP website at http://www.hp.com.

To install the HP Jetdirect print server

1  Remove the slot cover from the back of the printer.

2  Insert the print server as shown until it clicks.
3 Connect a network cable between the print server and the network.

4 Press the TEST button on the print server. The printer prints a configuration page for the print server. Keep this page because you might need the information on it.

5 Go to one of these sections to install the software on the computer that is acting as the server.
   - If you are going to use the printer in an environment with on Windows or both Windows and Mac OS users, see “Installing the printer driver on the server (Windows)”.
   - If you are using the printer in a Mac OS-only environment, see “Installing software for a network printer on a Macintosh”.

Installing the printer driver on the server (Windows)

After installing the print server card in the printer, you must install the printer driver on the computer that is acting as the server.

To install the printer driver on the server

1 Close any running applications.
   a Press CTRL+ALT+DELETE simultaneously on your computer keyboard and then click Task Manager.
   b Close any applications that are running. (Do not close Systray or Explorer.)
   c When finished, click the X in the upper-right corner of the Task Manager to close it.

2 Insert the Starter CD into the CD-ROM drive. The CD menu runs automatically.
   If the CD menu does not run automatically, click Start, and then click Run. At the command line box, type the letter of your computer’s CD-ROM drive followed by :\SETUP (for example, type D:\SETUP).

3 On the CD menu, click Install Printer Driver.

4 Choose your language, and then click OK.

5 Follow the instructions on the screen.

6 When prompted for the connection type, select the Connected via the network option and click Next. Then, select Basic network setup for a PC or server (recommended) and click Next.

7 When prompted, select the option to share the printer, and then select to install printer drivers for Windows clients. The installation program installs the printer driver for the server and copies the client drivers to a location on the server for users (clients).

8 Follow the instructions on the screen to complete the installation.

9 To allow Windows users to share this printer, see “Installing the software for a network printer on a Windows client”. To allow Mac OS users to share this printer, see “Installing software for a network printer on a Macintosh”.

Installing the software for a network printer on a Windows client

Once you have connected the printer to the network and installed the printer driver on the network computer acting as the server, you can share the printer. Individual Windows users, known as clients, can connect to the printer in these ways:

- In the Printers folder, double-click the Add Printer icon and follow the instructions for a network printer installation.
- Install the printer software from the Starter CD. When prompted, select Connected via the network, and then select Client Setup for client-server printing.
- On the network, browse to the printer and drag it to your Printers folder.
- Add the printer and install the software from the INF file that has been saved to a location on your network. Ask the network administrator where the INF file is located.

On the Starter CD the INF files are stored in folders using the following format: <CD>:\Windows\PCL3\<OS>\<language>. For example, if your CD drive letter is D:, then D:\Windows\PCL3\Win2k_XP\English would contain the English Windows 2000 PCL 3 INF file.

Installing software for a network printer on a Macintosh

When connecting the printer to a network in the Mac OS, make sure the HP Jetdirect print server is installed in the printer before you install the printer software. All Mac OS users who want to use the printer need to install the printer software as described below.

To install software for a network printer on a Macintosh

1. Insert the Starter CD into the CD-ROM drive. The CD menu runs automatically.
   - If the CD menu does not run automatically, double-click the CD icon on the desktop, and then double-click the Setup icon.
2. Click Install Driver.
3. Follow the instructions on the screen.
4. Complete the installation in one of these ways.
   - **Mac OS 8.6 to Mac OS 9.2.2:** See “To finish a network installation for Mac OS 8.6 to Mac OS 9.2.2” below.
   - **Mac OS X or later:** See “To finish a network installation for Mac OS X or later” below.

To finish a network installation for Mac OS 8.6 to Mac OS 9.2.2

1. When prompted, restart the computer.
2. Select Chooser from the Apple menu.
3. Select **hp deskjet xx** in the upper left window of the Chooser window, where xx represents the version of the current printer driver.
4. Select **hp business inkjet 1100** in the right window of the Chooser screen.
5. Close the Chooser.
To finish a network installation for Mac OS X or later

1 Open the Print Center, which is located in the Applications\Utilities folder.
2 Click Add.
3 Do one of the following steps.
   - If you are using an AppleTalk network, on the pop-up menu, select AppleTalk.
   - If you are using an IP network, on the pop-up menu, select IP Printer, and then type the IP address for the printer.
4 If necessary, select the Zone.
5 Select hp business inkjet 1100 from the printer list, and then click Add. A dot appears beside the printer name, indicating that this printer is now the default printer.
6 Close the Print Center.

Uninstalling the printing system software

Use the following steps to uninstall the printing system software.

Uninstalling software for Windows (all versions)

1 Close any running applications.
2 From the Start menu, open the Control Panel.
3 Double-click Add/Remove Programs.
4 Select the printing software that you wish to remove.
5 Click the button for adding or removing software.
6 Follow the instructions on the screen to complete the removal of the printer software.

Note
You must have administrator privileges to uninstall the printer software in Windows NT 4.0, Windows 2000, and Windows XP.

If the software was not successfully installed, or the Uninstaller could not be found, run the scrubber utility from the Starter CD. See the steps below.

Running the scrubber utility

1 Disconnect the printer from the computer.
2 On the computer, restart Windows.
3 Insert the Starter CD in the CD-ROM drive.
4 Locate the scrubber utility on the Starter CD-ROM and run the utility.
   - For Windows 98 and Windows Me, use the scrub9x.exe file located in the \Utils\Scrubber\Win9x_Me folder.
   - For Windows 2000 and Windows XP, use the scrub2k.exe file located in the \Utils\Scrubber\Win2k_XP folder.
Uninstalling software for Macintosh (all versions)

1 Restart the computer.

Note If you do not restart the computer before you uninstall the software, some files are not removed from your computer when you run the Uninstall option.

2 Insert the Starter CD into the CD-ROM drive.
3 Double-click the CD icon on the desktop.
4 Double-click the installer icon and follow the instructions on the screen.
5 When the Main Installation dialog box appears, select Uninstall from the drop-down list located in the upper-left part of the dialog box.
6 Follow the instructions on the screen to remove the printer software.

Using the embedded Web server

If an HP Jetdirect print server card is installed in the printer comes equipped with an embedded Web server. Using a standard Web browser, this remote management tool allows you to do the following tasks:

- Configure network protocol settings
- Configure network security settings

To use the embedded Web server, you must have a Web browser, and the printer must be connected to an IP-based network. (IPX/SPX networks are not supported.) You cannot use the embedded Web server when the printer is connected directly to a computer.

Gaining access to the embedded Web server

You can gain access to the embedded Web server from any supported Web browser. Type the IP address assigned to the printer into the Web browser. For example, if the printer IP address were 123.123.123.123, you would type http://123.123.123.123 into your Web browser.

If you do not know the IP address for the printer, it is listed on the HP Jetdirect configuration page. To print this page, press the TEST button on the print server card.

Embedded Web server pages

The embedded Web server, which contains information about the print server card, consists of these tabs:

- Home
- Networking

Home

The Home tab provides information about the printer, such as physical location, IP host name and address, hardware address, HP Jetdirect print server product number, and amount of time since the HP Jetdirect printer server was last turned off and on. You can also use the Home tab to reach network configuration, security, and diagnostic parameters.

Networking

The network pages of the embedded Web server allow the network administrator to configure the HP Jetdirect card for the printer. See the online Help and the HP Jetdirect Print Server Administrator’s Guide for more information. This guide is located on the Starter CD.
Making copies of the software

The Starter CD contains a utility that lets you copy the printer software onto disks, or to create custom installations, which is a task usually performed by system administrators. When you run the Installer, select **Customization Utility** to copy disks.

You can also use this utility to copy the printer software to your hard drive or to a network drive. After the files are copied to another location, you can install the printer software from that location.

Installing other software

The following drivers and optional software are also available for installation on the printer.

- **HP Web Jetadmin.** This is a Web browser-based network printer management tool. A link to the HP Web Jetadmin website is included on the Starter CD. See “Using HP Web Jetadmin” for more information about using this tool.


- **Printer installation software for UNIX® (HP-UX, Sun Solaris) networks.** This software is available for download at [http://www.hp.com/support/net_printing](http://www.hp.com/support/net_printing).

- **Information about using the IBM PostScript 3 emulation printer driver for IBM OS/2.** Visit [http://www.hp.com/support/businessinkjet1100](http://www.hp.com/support/businessinkjet1100).

If you are using Windows NT 4.0, Windows 2000, or Windows XP, you must have administrator privileges to install a printer driver.
Using the printer

In this section you will learn how to use the printer driver to change printer settings and to perform basic printer tasks. You will also learn about the special media that you can use with the printer and how to print on that media.

Selecting print media

Before you use the printer, take some time to familiarize yourself with the various media you can use.

The printer is designed to work well with most types of office paper and with 25 percent cotton bond paper. It is best to test a variety of print media types before buying large quantities. Find a media type that works well and is easy to purchase.

Note

Use HP media for optimum print quality. These print media types are specifically designed to work well with the printer. For ordering information and part numbers, see “HP supplies and accessories”.

Tips for selecting and using print media

For the best results, observe the following guidelines:

- Always use paper that conforms to the printer specifications. For a list of supported media, see “Understanding supported sizes” and “Understanding supported media types and weights”.
- Load only one paper type at a time into a tray.
- In Tray 1 and Tray 2, load media print-side down with the right edge of the media aligned against the right edge and front guide of the tray. See “Loading media”.
- Load no more than 150 sheets of media into Tray 1. If Tray 2 is installed, load no more than 250 sheets of plain paper into it.
- Do not use media that is damaged, curled, or wrinkled. Do not use paper with cutouts or perforations or paper that is heavily textured or embossed. These types of media can cause jams and other problems.
- Do not use paper that is too lightweight or stretches easily. These types of paper can feed improperly or jam. See “Understanding specifications for supported media”.
- Do not use multipart forms.
- Paper that is heavily textured or does not accept ink well can cause poorly filled graphics or text.
Understanding specifications for supported media

This section provides information regarding the sizes, types, and weights of media that the printer supports. It also provides information regarding the capacity of each tray and the envelope slot.

Understanding supported sizes

The following table provides detailed information about the sizes and types of media you can use with each paper path. For information about media types that each paper path supports, see "Loading media".

<table>
<thead>
<tr>
<th>Media size</th>
<th>Tray 1</th>
<th>Tray 2</th>
<th>Envelope slot</th>
<th>Auto-duplex unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>U.S. Letter (8.5 by 11 inches; 216 by 279 mm)</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>U.S. Legal (8.5 by 14 inches; 216 by 356 mm)</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A4 (8.3 by 11.7 inches; 210 by 297 mm)</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Executive (7.3 by 10.5 inches; 184 by 267 mm)</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ISO B5 (6.9 by 9.9 inches; 176 by 250 mm)</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A5 (5.8 by 8.3 inches; 148 by 210 mm)</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Envelope U.S. #10 (4.12 by 9.5 inches; 105 by 241 mm)</td>
<td>✔</td>
<td></td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Envelope DL (8.66 by 4.33 inches; 200 by 110 mm)</td>
<td>✔</td>
<td></td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Envelope C6 (4.49 by 6.38 inches; 114 by 162 mm)</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A2 (4.37 by 5.75 inches; 111 by 146 mm)</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Index card (3 by 5 inches; 76.2 by 127 mm)</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Index card (4 by 6 inches; 102 by 152 mm)</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Index card (5 by 8 inches; 127 by 203 mm)</td>
<td>✔</td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>ISO A6 card (4.13 by 5.83 inches; 105 by 149 mm)</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Banner paper (up to 8.5 inches wide and 234 inches long; up to 216 mm wide and 594.4 cm long)</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom-size media between 3 to 8.5 inches wide and 5 to 14 inches long (76.2 to 216 mm wide and 127 to 356 mm long)</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Understanding supported media types and weights**

This table provides information regarding the types and weights of media that each paper path can accept and the maximum capacity that each path can hold.

<table>
<thead>
<tr>
<th>Tray</th>
<th>Type</th>
<th>Weight</th>
<th>Capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tray 1</td>
<td>Paper</td>
<td>16 to 24 lb (60 to 90 g/m²)</td>
<td>Up to 150 sheets or 0.58 inch (15 mm) stacked</td>
</tr>
<tr>
<td></td>
<td>Transparencies or labels</td>
<td></td>
<td>Up to 30 (or 8 mm stacked)</td>
</tr>
<tr>
<td></td>
<td>Envelopes</td>
<td>20 to 24 lb (75 to 90 g/m²)</td>
<td>Up to 22 (or 15 mm stacked)</td>
</tr>
<tr>
<td></td>
<td>Cards</td>
<td>Up to 110 lb index (200 g/m²)</td>
<td>Up to 60 (or 15 mm stacked)</td>
</tr>
<tr>
<td>Tray 2</td>
<td>Paper (plain only)</td>
<td>16 to 24 lb (60 to 90 g/m²)</td>
<td>Up to 250 sheets or 0.98 inches (25 mm) stacked</td>
</tr>
<tr>
<td>Envelope feed</td>
<td>Envelopes</td>
<td>20 to 24 lb (75 to 90 g/m²)</td>
<td>1 at a time</td>
</tr>
<tr>
<td>Auto-duplex unit</td>
<td>Paper</td>
<td>16 to 24 lb (60 to 90 g/m²)</td>
<td>1 at a time</td>
</tr>
<tr>
<td></td>
<td>Cards</td>
<td>Up to 90 lb index (160 g/m²)</td>
<td>1 at a time</td>
</tr>
</tbody>
</table>
Setting minimum margins

The document margins must match (or exceed) these minimum margin settings in portrait orientation. The illustration below shows which side of the paper and envelope corresponds to each margin.

<table>
<thead>
<tr>
<th>Media</th>
<th>Left margin</th>
<th>Right margin</th>
<th>Top margin</th>
<th>Bottom margin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Letter, legal, executive, banner (letter)</td>
<td>0.25 inch</td>
<td>0.25 inch</td>
<td>0.12 inch</td>
<td>0.50 inch</td>
</tr>
<tr>
<td></td>
<td>(6.4 mm)</td>
<td>(6.4 mm)</td>
<td>(3.0 mm)</td>
<td>(12.7 mm)</td>
</tr>
<tr>
<td>A4, A5, ISO B5, cards, banner (A4)</td>
<td>0.13 inch</td>
<td>0.13 inch</td>
<td>0.12 inch</td>
<td>0.50 inch</td>
</tr>
<tr>
<td></td>
<td>(3.4 mm)</td>
<td>(3.4 mm)</td>
<td>(3.0 mm)</td>
<td>(12.7 mm)</td>
</tr>
<tr>
<td>HP Greeting Card Envelope</td>
<td>0.12 inch</td>
<td>0.13 inch</td>
<td>0.50 inch</td>
<td>0.50 inch</td>
</tr>
<tr>
<td></td>
<td>(3.0 mm)</td>
<td>(3.4 mm)</td>
<td>(12.7 mm)</td>
<td>(12.7 mm)</td>
</tr>
<tr>
<td>All other size envelopes</td>
<td>0.13 inch</td>
<td>0.13 inch</td>
<td>0.50 inch</td>
<td>0.50 inch</td>
</tr>
<tr>
<td></td>
<td>(3.4 mm)</td>
<td>(3.4 mm)</td>
<td>(12.7 mm)</td>
<td>(12.7 mm)</td>
</tr>
<tr>
<td>Custom-size media</td>
<td>0.12 inch</td>
<td>0.12 inch</td>
<td>0.12 inch</td>
<td>0.50 inch</td>
</tr>
<tr>
<td></td>
<td>(3.0 mm)</td>
<td>(3.0 mm)</td>
<td>(3.0 mm)</td>
<td>(12.7 mm)</td>
</tr>
<tr>
<td>Photo (4 by 6 inches, or 101.6 by 152.4 mm)</td>
<td>0.13 inch</td>
<td>0.13 inch</td>
<td>0.12 inch</td>
<td>0.12 inch</td>
</tr>
<tr>
<td>with tear-off tab</td>
<td>(3.4 mm)</td>
<td>(3.4 mm)</td>
<td>(3.0 mm)</td>
<td>(3.0 mm)</td>
</tr>
</tbody>
</table>

Note

When you are using the auto-duplex unit, the minimum top and bottom margin must match or exceed 0.46 inch or 11.7 mm.
Loading media

This section contains instructions for loading media into Tray 1 or Tray 2. To load a single card or envelope in the envelope slot, see “Printing on envelopes and cards”.

To load Tray 1 or Tray 2

1 Pull the tray out of the printer.

2 If you are loading paper in Tray 1 raise and remove the output tray.

3 To load paper between 11 inches (279 mm) and 14 inches (356 mm) long, move the latch on the tray to the right and lower the front of the tray. (You do not need to lower the front of the tray for letter-size or A4-size paper.)
4 Adjust the width and length guides to the size marking for the paper you are loading. Then, insert the paper.

5 If you are loading Tray 1, reattach the output tray.

6 Insert the tray back into the printer.

**CAUTION**
If you have loaded legal-size or longer paper, keep the front of the tray lowered. Damage to the paper or printer can result if you raise the front of the tray with this longer paper loaded.
7 Pull out the paper extension on the output tray.

8 Select the appropriate media type option in your application or printer driver.

By default, the printer draws paper from Tray 2, if it is installed. If Tray 2 is empty, the printer draws paper from Tray 1 unless you have selected the “lock” feature in the Toolbox. See “Setting the tray lock”.

### Configuring trays

When you print a document, you can allow the printer to select the correct tray for the print job, or you can select a specific tray for the current print job. These settings are available in the printer driver in the **Source is** drop-down menu (Windows) and in the **Print** dialog box in the **Paper Source** or **Source** box (Mac OS).

If you do not select a tray in the printer driver, the printer automatically selects a tray. By default, the printer draws paper from Tray 2 first, if it is installed. Computers running Windows can use the Toolbox to set Tray 1 as the default tray or lock a tray. A **Windows user who sets these settings for a network printer will be setting them for all users of the printer, including Mac OS users**.

The following table lists possible ways you can use the trays to meet your printing needs.

<table>
<thead>
<tr>
<th>Tray usage</th>
<th>Steps to complete</th>
<th>For more information</th>
</tr>
</thead>
</table>
| I want to load both trays with the same paper, and I want the printer to pull paper from one tray if the other one is empty. | 1 Load paper in Tray 1 and Tray 2.  
2 Make sure tray lock is off in the Toolbox (Windows). |  
- Loading paper trays: See “Loading media”.  
- Using the tray lock: See “Setting the tray lock”.  
- Selecting a default tray: See “Selecting a default tray”. |
| I want to load special media (such as transparencies or letterhead) in Tray 1 and plain paper in Tray 2. | 1 Load the special media in Tray 1, and then load the plain paper in Tray 2.  
2 Lock Tray 1 from the Toolbox (Windows). |  |
| I want to have paper in both trays, but I want the printer to pull paper from Tray 1 first. | 1 Load paper in Tray 1 and Tray 2.  
2 Set the default tray to Tray 1 from the Toolbox (Windows). |  |

**Note**

Tray 2 is meant for plain paper only.
Setting the tray lock

This feature is only available if Tray 2 is installed in your printer and you have a computer that is running Windows. If the printer is on a network and you set tray lock, you will be setting it for all users of the printer, including Mac OS users.

Use the tray lock to protect special media such as letterhead or preprinted paper from accidental use. If the printer runs out of paper while printing a document, it will not use paper from a locked tray to complete the print job.

To set tray lock (Windows)

1. Make sure the printer is on.
2. Open the Toolbox.
3. On the Printer Services tab, click Advanced Configuration.
4. In the Lock Tray area, select the tray that you want to lock from accidental use and click OK.

Selecting a default tray

This feature is only available if Tray 2 is installed in your printer and you have a computer that is running Windows. If the printer is on a network and you select a default tray, you will be setting it for all users of the printer, including Mac OS users.

Use the default tray setting to determine the first tray from which the printer draws media when Auto Select is selected as the Source in the printer driver. The default tray setting is useful in these situations:

- The same media is loaded in both trays.
- Tray 2 is installed and loaded with a size that you do not want to use for most jobs.

Note that Tray 2 is automatically set as the default tray if you have not changed this setting. However, Tray 1 is automatically selected if you choose in the printer driver any type of media except plain paper (make sure that the printer driver is set up to do this).

To select a default tray (Windows)

1. Make sure the printer is on.
2. Open the Toolbox.
3. On the Printer Services tab, click Advanced Configuration.
4. In the Default Tray area, select the tray that you want to be the default and click OK.
Understanding default tray behavior for the Mac OS

For the Mac OS, Tray 2 is always the default tray except under these circumstances:

- You select a size or type that is not supported by Tray 2. The printer automatically selects Tray 1.
- You place an envelope in the envelope slot. The printer automatically pulls the envelope first.
- You are using the printer on a network and a Windows user has set Tray 1 as the default tray in the Toolbox. See “Selecting a default tray”.
- When you are printing the current job, you select Tray 1 from the Paper Source or Source box in the Print dialog box.

For more information about changing settings just for the document you are printing, see “To change settings from an application (current jobs)” or “Changing settings for the Mac OS”.

Printing using the PCL 3 printer driver

In most situations, you will probably print documents using the printer driver. Although specific options vary depending on the application you are using, you can usually gain access to the printer driver by clicking File and then clicking Print in the application.

For more information about printer driver features, see the printer driver online Help. For more information about printing from a specific application, see the documentation for that application. For information about printing from a Macintosh computer, see “Changing settings for the Mac OS”.

To print using the PCL 3 printer driver

1. On the File menu, click Print.
2. On the Name drop-down menu, select the PCL 3 printer driver, and then click Properties or Setup. (The options might be different for your application.)
3. On the Source is drop-down menu, select the location of the media on which you want to print.
   - To print an envelope, card, or other special media using Tray 1, select Manual Feed (Tray 1). For information about loading Tray 1, see “Loading media”.
   - To print from a specific tray, select Tray 1 or Tray 2 (if available).
4. On the Type is drop-down menu, select the type of media you want to print.
5. Click the Paper tab.
6. On the Print Quality drop-down menu, select a print mode.
7. Change other print settings, if necessary, and then click OK.
8. Click Print.
Changing printer settings

The printer driver stores the default print settings for most applications. You need to change these settings when you print on media of different sizes or types, or when you want to use an optional feature, such as printing to Tray 2, which is included with the HP Business Inkjet 1100dtn and optional with the HP Business Inkjet 1100d.

You can change print settings for a single document from the application that the document was created in. To change the default print settings for all documents, you must open the printer driver from the Start menu.

Changing settings for Windows

The printer driver stores the default print settings for most applications. You need to change these settings when you print on media of different sizes or types, or when you want to use an optional feature, such as printing to Tray 2 or printing on both sides of a sheet of paper.

You can change printer settings from an application or the printer driver. Try to make changes from the application first. Changes made to settings from an application always take precedence over changes made to settings from the printer driver.

If you want to change settings only for the jobs you are printing from the application that is currently open, change the settings from the application. After you close the application, the printer settings return to the defaults configured in the printer driver. If you want to set printing options for all jobs you print from all applications, change the default settings in the printer driver.

To change settings from an application (current jobs)

1. With a document open, on the File menu, click Print, and then click Setup or Properties.
2. Change the settings and click OK, Print, or a similar command.

To change default settings (all future jobs)

1. Open the printer driver in one of these ways.
   - For Windows 98, Me, NT 4.0, and 2000: From the Windows desktop, click Start, point to Settings, and then click Printers.
   - For Windows XP: Click Start, point to Settings, and then click Printers and Faxes.
2. Right-click the printer icon, and then choose one of these options.
   - For Windows 98 and Me: Click Properties.
   - For Windows NT 4.0: Click Document Defaults or Properties.
   - For Windows 2000 and XP: Click Printing Preferences or Properties.
3. Change any settings and click OK. The settings you chose will apply to all documents printed from all applications. You can override these settings from the printer driver just for the job you are currently printing. See “To change settings from an application (current jobs).”

Note For additional information, go to http://www.hp.com/support/businessinkjet1100.
To set the default media type

Note
Use this procedure to set the default media type to Automatic.

1. Gain access to the default printer settings as described above.
2. On the Paper or Paper/Quality tab, select Automatic in the Type is box and click OK.

For best printing results, still select the type of media you are using each time you print a document.

Changing settings for the Mac OS

You can change printer settings from the Page Setup and Print dialog boxes in the Mac OS. You can also select the default printer. The default printer is the one that is used if you choose the Print command without first specifying which printer you want to use with an application. The default printer should be the printer that you use most often.

Note
For more information about using the Mac OS to change printer settings, see the Mac Help on your computer.

To change page setup settings

1. Open the document you want to print.
2. On the File menu, click Page Setup.
3. On the Format for pop-up menu, select the printer for which you want to format the document, and then change the desired settings (such as selecting the type of media and setting custom page sizes).
4. On the Page Size pop-up menu (Mac OS 8.6 to Mac OS 9.2.2) or the Paper Size pop-up menu (Mac OS X), select the media size on which you want to print.
5. Click OK.

To change print settings

1. Open the document you want to print.
2. On the File menu, click Print.
3. Select the media or the type of media on which you want to print:
   - Mac OS 8.6 to Mac OS 9.x: On the Paper Type/Quality panel, select the media source or the media type.
   - Mac OS X: On the Copies & Pages panel, click All. On the Paper/Quality panel, select the media source or the media type.
4. If you have Tray 2 installed and want to print from Tray 1, select Tray 1 in one of these ways:
   - Mac OS 8.6 to Mac OS 9.x: On the General panel, select Tray 1 in the Paper Source pull-down menu.
   - Mac OS X: On the Paper/Quality panel, select Tray 1 in the Source pull-down menu.
5. Change any other settings you want, such as choosing a print quality mode.
6. Click Print.
Performing printer tasks

In this section, you can find information about how to send documents to print, how to print on special media, and how to print on media of user-defined size.

Canceling a print job

You can cancel a print job in these ways:

- Press the (cancel button) on the printer. [Pressing the (cancel button) clears the job that the printer is currently processing. It does not affect jobs waiting to be processed.]
- For Windows, double-click the printer icon that appears in the lower right corner of the computer screen. Select the document you want to cancel. On the Document menu, click Cancel.
- For Mac OS 8.6 to 9.x, double-click the desktop printer icon, select the print job, and then click Trash.
- For Mac OS OS X, click the Print Center icon. In the Printer List dialog box, double-click the printer icon. In the HP Business Inkjet 1100 dialog box, select the print job and click Delete.

Printing on both sides (duplexing)

You can print on both sides of a sheet of paper automatically using the auto-duplex unit. This is called automatic duplexing. To print on both sides of a page, you must specify duplex options in your application or in the printer driver.

Guidelines for printing on both sides of a page

When printing on both sides of the page using the optional auto-duplex unit, use the following guidelines:

- The auto-duplex unit supports the following paper sizes: letter, legal, executive, A4, and ISO B5. It does not support smaller sizes or custom sizes.

  Minimum width: 3 inches (100 mm)
  Maximum width: 8.5 inches (216 mm)
  Minimum length: 5 inches (148 mm)
  Maximum length 11.7 inches (292 mm)

- To print on both sides of paper, make the selection from the application or printer driver. See “Performing automatic duplexing”.

- The minimum top margin should be at least 0.5 inch (12 mm).

- Do not print on both sides of transparencies, banner media, envelopes, plain premium inkjet paper, photo paper, brochure paper, glossy media, or paper lighter than 16 lb bond (60 g/m²) or heavier than 24 lb bond (90 g/m²). Jams might occur with these types of media.

- Several kinds of paper require a specific orientation when you print on both sides of a page, such as letterhead, preprinted paper, and paper with watermarks and prepunched holes. The auto-duplex unit prints the second side of paper first. For Tray 1 and Tray 2, load the paper with the front side facing down.
Performing automatic duplexing

When printing is complete on one side of the paper, the printer holds the paper and pauses while the ink dries. Once the ink is dry, the paper is pulled back into the printer and the second side of the paper is printed. When printing is complete, the paper is dropped on to the output tray.

For more information on setting print options, see “Changing printer settings”.

To perform automatic duplexing (Windows)

1 Load the appropriate paper in Tray 1 or Tray 2. Be sure to load the paper with the print side up.

2 On the File menu, click Print, and then click Properties. (The actual steps can vary; this is the most common method.)

3 On the Finishing tab, select the Print on Both Sides check box. Make sure that the Automatic check box is selected.

4 When duplexing, the top margin might need to be increased slightly to make sure the pages align. Select the Preserve Layout check box to reduce the margins so that the page prints on a single sheet. Clear this check box if you prefer that the page print on more than one sheet with full margins.

5 Select or clear the Flip Pages Up check box depending on which way you want the binding. See the graphics in the printer driver for examples.

6 Click OK to close the dialog box.

7 Click OK to print.

To perform automatic duplexing (Mac OS 8.6 to 9.x)

1 Load the appropriate paper in Tray 1 or Tray 2. Be sure to load the paper with the print side down.

2 On the File menu, click Print.

3 On the Layout panel, select the Print Both Sides check box, select the binding orientation you want (select the desired icon), and select Automatic.

4 Click OK.

To perform automatic duplexing (Mac OS X)

1 Load the appropriate paper in Tray 1 or Tray 2. Be sure to load the paper with the print side up.

2 On the File menu, click Print.

3 On the Two Sided Printing panel, select the Print Both Sides check box, the binding orientation you want (select the desired icon), and select Automatic.

4 Print the document.
Performing manual duplexing

If you want, you can duplex manually. Leave the auto-duplex unit in place. You will choose Manual duplexing in the printer driver.

To perform manual duplexing (Windows)

1. Load the appropriate paper in Tray 1 or Tray 2.
2. On the File menu, click Print, and then click Properties. (The actual steps can vary; this is the most common method.)
3. On the Basics tab, select Back to Front under Page Order.
4. On the Finishing tab, select the Print on Both Sides check box. Make sure that the Automatic check box is cleared.
5. When duplexing, the top margin might need to be increased slightly to make sure pages align. Select the Preserve Layout check box to reduce the margins so that the page prints on a single sheet. Clear this check box if you prefer that the page print on more than one sheet with full margins.
6. Select or clear the Flip Pages Up check box depending on which way you want the binding. See the graphics in the printer driver for examples.
7. Click OK to close the dialog box.
8. Click OK to print.
9. Depending on your type of printer connection, do one of the following steps.
   - For directly connected printers: After the first side prints, a dialog box appears on your computer. Follow the instructions on the screen for reloading the job and then click Continue.
   - For network-connected printers: When the first side of the job has printed, the Resume light blinks. If the Toolbox is installed, the Toolbox shows a dialog box to show you how to reload the job.
10. Press the ″ (resume button) on the printer.

For more information on setting print options, see “Changing printer settings”.

To perform manual duplexing (Mac OS 8.6 to 9.x)

1. Load the appropriate paper in Tray 1 or Tray 2. Be sure to load the paper with the print side up.
2. On the File menu, click Print.
3. On the Layout panel, select the Print Both Sides check box, the binding orientation you want (select the desired icon), and select Manual.
4. Click OK.
5. When the first side of the job has printed, the Resume light blinks. Take the document that has printed, rotate it 180 degrees (with the printed side facing up), and load it in the tray so that the top of the printed page faces the printer.
6. Press the ″ (resume button) on the printer.
To perform manual duplexing (Mac OS X)

1. Load the appropriate paper in Tray 1 or Tray 2. Be sure to load the paper with the print side up.
2. On the File menu, click Print.
3. On the Two Sided Printing panel, select the Print Both Sides check box, the binding orientation you want (select the desired icon), and select Manual.
4. Print the document.
5. When the first side of the job has printed, the Resume light blinks. Reload the job into the tray.
6. Press the (resume button) on the printer.

Printing photographs

You can print photographs from your digital camera from a software application such as HP Photo Printing Software.
Use Best mode to print photographs. In this mode, printing takes longer and more memory is required from your computer.
Remove each sheet of media as it prints and set it aside to dry. Allowing wet media to stack up can cause smearing.

To print digital photographs (Windows)

1. Load the appropriate paper in Tray 1 or Tray 2. Be sure to load the paper with the print side down.
2. On the File menu, click Print, and then click Properties. (The actual steps can vary; this is the most common method.)
3. On the Paper/Quality tab, select the paper type you are using from the Type is menu (for example, HP Premium Plus Photo Paper).
4. Under Print Quality, click Best.
5. Select the paper size from the Size is menu.
6. Change any other print settings if necessary.
7. Click OK to close the dialog box.
8. Click OK to print.

To print digital photographs (Macintosh)

1. Load the appropriate paper in Tray 1 or Tray 2. Be sure to load the paper with the print side up.
2. Open the Paper Type/Quality panel.
3. Select the paper type you are using (for example, HP Premium Photo Paper).
4. Click the Quality tab and select Best.
5. Change any other print settings if necessary.
Printing on special media

This section provides information about how to print on media such as envelopes, postcards, and transparencies.

Printing on envelopes and cards

You can print envelopes from the envelope slot or Tray 1. You can print cards from Tray 1. Cards must be at least 3 by 5 inches (76.2 by 127 mm) in size.

Note

Use the envelope slot to print a single envelope. If you need to print cards or more than one envelope, use Tray 1. See “To load envelopes or cards in Tray 1”.

Tips for printing envelopes

Observe the following guidelines to avoid jams and wrinkled or torn output:

- Avoid envelopes that have a very slick finish, self-stick adhesives, clasps, or windows. Also avoid envelopes with thick, irregular, or curled edges, or areas that are wrinkled, torn, or otherwise damaged.
- Use a sturdy envelope of approximately 16 to 27 lb (60 to 101 g/m²) weight. Use tightly constructed envelopes, and make sure the folds are sharply creased.

To print envelopes from the envelope slot (Windows)

1. On the File menu, click Print, and then click Properties. (The actual steps can vary; this is the most common method.)
2. On the Paper/Quality tab, select Manual feed (Tray 1) in the Source is box.
3. Change other print settings, if necessary, and click OK.
4. When the Resume light on the printer blinks, insert one envelope with the flap facing upwards into the envelope slot. Ease the envelope to the right edge.
5. Press the (resume button) on the printer to continue printing.
To print envelopes from the envelope slot (Mac OS)

2. In the Page Size pull-down menu, select the envelope size.
3. Change any other settings and click OK.
4. On the File menu, click Print and click OK.
5. When the Resume light on the printer blinks, insert one envelope with the flap facing upwards into envelope slot. Ease the envelope or card to the right edge.

6. Press the (resume button) on the printer to continue printing.

To load envelopes or cards in Tray 1

1. Lift the output tray and remove all media from the tray. Insert the stack of cards or envelopes into the tray with the flaps facing up and to the right.
2. Slide the paper width and length guides in until they stop at the edges of the envelopes or cards.
3. Lower the output tray. Go to “To print envelopes or cards from Tray 1 (Windows)” or “To print envelopes or cards from Tray 1 (Mac OS 8.6 to OS X)”.

To print envelopes or cards from Tray 1 (Windows)

1. On the File menu, click Print, and then click Properties. (The actual steps can vary; this is the most common method.)
2. On the Paper/Quality tab, select the paper type you are using in the Type is box (for example, HP Glossy Greeting Card Paper).
3. Select the envelope or card size from the Size is menu.
4. Change any other print settings, if necessary, and then click OK.
5. Send your job to print.

To print envelopes or cards from Tray 1 (Mac OS 8.6 to OS X)

2. On the Layout panel, select the size from the Paper Size pull-down menu.
3. Change any other settings and click OK.
4. On the File menu, click Print.
5. On the Paper Type/Quality panel, select the paper type you are using from the Group pull-down menu (such as Greeting Cards).
In the **Type** pull-down menu, select the specific type of envelope or card you are using (such as HP Glossy Greeting Card Paper).

Change any other settings if necessary, then click **OK**.

**Printing on transparencies**

You can print transparencies from Tray 1. For best results, use HP Premium Plus Inkjet Transparency Film, which is specifically designed to work with the printer, or other transparency film that is designed for inkjet printers.

**To load transparencies**

1. Remove all media from Tray 1. Insert the transparencies with the rough side down and the adhesive strip pointing forward.

2. Slide the width and length guides until they stop at the edge of the transparencies. Slide the tray back into its closed and locked position.

**To print transparencies (Windows)**

1. On the **File** menu, click **Print**, and then click **Properties**. (The actual steps can vary; this is the most common method.)

2. On the **Paper/Quality** tab, under **Print Quality**, select **Best** in the drop-down menu.

   **Note**

   Use **Best** mode to print transparencies. Because this mode provides a longer drying time, it ensures that the ink dries completely before the next page is delivered to the output tray.

3. Under **Type is**, select **Transparency Films**.

4. Under **Size is**, select the appropriate size for the transparency you are printing.

5. Change any other print settings, if necessary, and then click **OK**.

6. Send your job to print.

7. Remove each sheet of media as it prints and set aside to dry. Allowing wet media to stack up might cause smearing.

**To print transparencies (Mac OS 8.6 to 9.x)**

1. On the **File** menu, click **Page Setup**.

2. In the **Page Size** pull-down menu, select size, change any other settings, and click **OK**.

3. On the **File** menu, click **Print**.

4. On the **Paper Type/Quality** panel, select **Transparency Film** from the **Group** pull-down menu.

5. In the **Type** pull-down menu, select the specific transparency type you are using (such as HP Premium Plus Inkjet Transparency film).

6. Click the **Quality** tab and select **Best**.

   **Note**

   Use **Best** mode to print transparencies. This mode provides a longer drying time and ensures that the ink dries completely before the next page exits the printer.

7. Change any other print settings if necessary, then click **OK**.

8. Remove each sheet of media as it prints and set aside to dry. Allowing wet media to stack up might cause smearing.
To print transparencies (Mac OS X)

2. In the Paper Size pull-down menu, select size, change any other settings, and click OK.
3. On the File menu, click Print.
4. On the Paper Type/Quality panel, select the Paper tab.
5. In the Paper type pull-down menu, select the transparency type you are using.

**Note**
Use Best mode to print transparencies. This mode provides a longer drying time and ensures that the ink dries completely before the next page exits the printer.

7. Change any other print settings if necessary, and then click OK.
8. Remove each sheet of media as it prints and set aside to dry. Allowing wet media to stack up might cause smearing.

Printing on custom-size media

You can print custom-size media from Tray 1. When you want to print on custom-size media, you need to adjust the length and width guides in the tray, and, if necessary, extend the tray size to accommodate larger media.

- Use Tray 1 when printing on paper that is 3 to 8.5 inches wide and 5 to 14 inches long (76.2 to 216 mm wide and 127 to 356 mm long).
- If your application supports custom-size media, set the media size in the application before creating and printing the document. If your application does not support custom size media, set the size in the printer driver, create the document, and then print it. (You might need to reformat existing documents to print them correctly on custom paper sizes.)

For information about extending the tray size, see “Loading media”.

To load custom-size media

1. Raise the output tray and remove all media from Tray 1.
2. Insert the custom-size media into the tray.
3. Slide the width and length guides until they stop at the edges of the media. The guides should be snug against the media without bending it.

**CAUTION**
Sliding the guides too tightly against the media can cause jams.

4. Lower the output tray.

To print custom-size media (Windows)

1. On the File menu, click Print, and then click Properties. (The actual steps can vary; this is the most common method.)
2. On the Paper/Quality tab, select the media type from the Type is box.
3. Click the Custom tab, select the media type from the Type is box.
4. Enter the dimensions of the paper in the Custom Paper Size dialog box, and then click OK.
5. Change any other print settings, if necessary, and then click OK.
6. Send your job to print.
To print custom-size media (Mac OS 8.6 to 9.x)
1 On the File menu, click Page Setup.
2 In the Page Size pull-down menu, click Edit Custom Paper Sizes.
3 In the Name box, type a name for this custom page size.
4 In the Width and Height boxes, type the dimensions and click Add.
5 Click Done.
6 On the File menu, click Print.
7 Open the Page Setup dialog box and select the name that you gave this custom page size.
8 Change any other settings if necessary.
9 Print the document.

To print custom-size media (Mac OS X)
1 On the File menu, click Page Setup.
2 In the Settings pull-down menu, click Custom Paper Size.
3 Click New.
4 In the Name box, type a name for this custom page size.
5 In the Width and Height boxes, type the dimensions and set the margins.
6 Click OK.
7 On the File menu, click Print.
8 Open the Page Setup dialog box and select the name that you gave this custom page size. T
9 Change any other settings if necessary.
10 Print the document.
Using diagnostic tools

HP provides several sources of help for you when you need information about the printer or when you need help solving a printer problem.

Using the Toolbox

The Toolbox, which is available only to Windows users, provides status and maintenance information about your printer. It also gives you step-by-step guidance for basic printing tasks and provides help solving printer problems.

After installing your printer, you can open the Toolbox by clicking Start, pointing to Programs, pointing to hp business inkjet 1100, and clicking hp business inkjet 1100 printer Toolbox.

The Toolbox has three tabs:

- Printer Status tab
- Information tab
- Printer Services tab

Printer Status tab

The Printer Status tab shows printer status and ink level information for each ink cartridge in 12.5 percent increments. The drop-down list displays the currently selected printer. The status window displays the printer status.

The Ink Level Information box displays status information about the installed cartridges, including the amount of ink available in the cartridges.

To select the Toolbox messages that appear, click Preferences from the Printer Status tab.

This table describes the buttons in the Printer Status tab and what you will find when you click each button.

<table>
<thead>
<tr>
<th>Button</th>
<th>What clicking the button does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order Supplies</td>
<td>Opens a temporary HTML file containing a disclaimer and agreement to send your information to the HP website. If you accept the disclaimer, you are connected to the HP website for supplies ordering.</td>
</tr>
<tr>
<td>Ink Cartridge Information</td>
<td>Opens a dialog box that shows the type of cartridges the printer uses. The dialog box also provides links to ordering information and retailer information.</td>
</tr>
<tr>
<td>Preferences</td>
<td>Opens a dialog box that allows you to select which Toolbox messages appear when a printer event occurs.</td>
</tr>
</tbody>
</table>
Information tab

The Information tab lets you register the printer, check for a new printer driver, view printer hardware and printhead health information, and gain access to an online ink usage page for your printer. It also gives you access to help information about using the printer, troubleshooting, and contacting HP.

This table describes the buttons in the Information tab and what you will find when you click each button.

<table>
<thead>
<tr>
<th>Button</th>
<th>What clicking the button does</th>
</tr>
</thead>
<tbody>
<tr>
<td>myPrintMileage</td>
<td>Opens the myPrintMileage website and your printer usage information, including printer usage patterns (ink and media use).</td>
</tr>
<tr>
<td>Printer Hardware</td>
<td>Opens a dialog box that shows the printer model, firmware version, and service identification number</td>
</tr>
<tr>
<td>Printhead health</td>
<td>Opens a dialog box that shows information about the condition of the printheads. This information appears graphically and shows whether each printhead is in Good, Fair, or Bad condition.</td>
</tr>
<tr>
<td>hp instant support</td>
<td>Opens the hp instant support website for support services and troubleshooting tips.</td>
</tr>
<tr>
<td>Register Your Printer</td>
<td>Opens a dialog box that guides you through registering the printer online.</td>
</tr>
<tr>
<td>How Do I...</td>
<td>Opens a dialog box that shows a list of common printer tasks and provides help on common maintenance tasks.</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>Opens a dialog box that shows a list of common printing problems and provides step-by-step instructions to help solve them.</td>
</tr>
<tr>
<td>Contact HP</td>
<td>Opens a dialog box that shows how to contact HP.</td>
</tr>
</tbody>
</table>

Printer Services tab

The Printer Services tab provides utilities that help you maintain and test your printer. You can clean and align your printheads, and calibrate the color on your printouts. You can also configure the Tray Lock setting and set a default tray (if Tray 2 is installed).

This table describes the buttons in the Printer Services tab and what you will find when you click each button.

<table>
<thead>
<tr>
<th>Button</th>
<th>What clicking the button does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Align Printheads</td>
<td>Opens a dialog box that guides you through aligning the printheads.</td>
</tr>
<tr>
<td>Clean Printheads</td>
<td>Opens a dialog box that guides you through cleaning the printheads.</td>
</tr>
<tr>
<td>Calibrate Color</td>
<td>Opens a dialog box that allows you to calibrate color manually.</td>
</tr>
<tr>
<td>Print a Demo page</td>
<td>Prints a demonstration page. This is used to verify that the printer is connected to the computer correctly and that the printer and printer software are working properly.</td>
</tr>
<tr>
<td>Advanced Configuration</td>
<td>Opens a dialog box that allows you to set tray lock and select a default tray (if Tray 2 is installed).</td>
</tr>
</tbody>
</table>
Using hp instant support

hp instant support is a Web-based tool that provides you with product-specific services, troubleshooting tips, and information about your printer’s ink and media usage (using myPrintMileage). With this information, you can diagnose and solve printer problems and manage your printing activities and printer supplies more effectively.

hp instant support provides the following information about your printer:

- **Easy access to troubleshooting tips**
  To help you quickly resolve printer problems or prevent some problems from happening, hp instant support provides tips that are customized for your printer.

- **Notification of printer driver and firmware updates**
  When a firmware or driver update for your printer is available, a notification message will appear on the hp instant support homepage. You can open the download site from the Web page.

- **Access to hp services**
  From the website, you can find out more about the support services available for your printer (such as maintenance programs), get information about service providers, and also make online purchase of printer supplies and accessories.

- **Notification of warranty expiration**
  When the printer warranty is expiring, a notification message will appear on the hp instant support homepage.

---

**Note**

hp instant support Web pages are created dynamically. Bookmarking this site and opening the site using the bookmark will not display the current information. Instead, open the Toolbox and on the **Information** tab, click the **hp instant support** button.
Using myPrintMileage

myPrintMileage keeps track of your printer usage information to help you plan the purchase of consumables. It consists of two parts:

- myPrintMileage website.
- myPrintMileage Agent. (This is a utility installed on your computer with the Toolbox. The Agent is activated during installation of the printer software only if you choose to participate.)

In order to use the myPrintMileage website and the myPrintMileage Agent, you must have the following:

- The Toolbox installed.
- An Internet connection.
- The printer connected.

You can visit the myPrintMileage website from the Toolbox by clicking the myPrintMileage button on the Information tab, or by right-clicking the myPrintMileage Agent icon in the Windows taskbar (near the clock) and selecting View my print usage. On this website, you will be able to see the following items:

- The amount of ink you have used. (myPrintMileage forecasts how many ink cartridges you might use in one year.)
- Whether you use more black or color ink.
- The average quantity of media you use per month for each media type.
- Number of pages printed, and the estimated number of pages you can print with the amount of ink remaining.

myPrintMileage Web pages are dynamically created. Do not bookmark this page. Instead, open the Toolbox and on the Information tab, click the myPrintMileage button.

You can enable and disable myPrintMileage at any time by right-clicking the myPrintMileage Agent icon on the taskbar and clicking Enable or Disable.
Using the HP Inkjet Utility

For Mac OS 8.6, 9.x and OS X, the HP Inkjet Utility contains tools to calibrate the printer, clean the printheads, print a test page, print a configuration page for the printer, set tray lock, and find website support information.

To display the HP Inkjet Utility
1  Double-click the Macintosh HD icon on the desktop.
2  Do one of the following steps.
   •  Mac OS 8.6 to Mac OS 9.0: Select Utilities and select hp deskjet.
   •  Mac OS 9.1: Select Applications (Mac OS 9), select Utilities, and select hp deskjet.
   •  Mac OS X: Select Applications and select Utilities.
3  Select hp inkjet utility.

Viewing the HP Inkjet Utility panels
The following options are available on the HP Inkjet Utility Panel menu.
•  WOW! Prints a sample page to view the print output quality.
•  Ink Level. Displays ink levels in the ink cartridges.
•  Test. Prints a test page.
•  Configuration. Prints a configuration page.
•  Clean. Cleans the printheads.
•  Calibrate Device. Aligns the printheads.
•  Calibrate Color. Adjusts color to correct problems with tint.
•  Support. Provides access to the HP website where you can find support for the printer and information about HP products and supplies.
•  Register. Accesses the HP website to register the printer.
Using HP Web Jetadmin

HP Web Jetadmin is a Web-based system administration tool that allows remote installation and management of networked peripherals from a Web browser. It enables network administrators to configure network printers, manage printer features, and monitor printer status, including levels for printer supplies.

HP Web Jetadmin supports IP-based networks only. This browser-based software can be installed and hosted on one of the following supported platforms:

- Windows NT 4.0, 2000, or XP
- Red Hat Linux
- SuSE Linux

To download HP Web Jetadmin software and for the latest information, go to http://www.hp.com/go/webjetadmin.

Using the deskjet control panel (DJCP)

Some software manufacturers do not develop printer drivers for their MS-DOS® programs. The deskjet control panel (DJCP) can allow you to gain access to certain useful printer features when you are printing from DOS. The DJCP utility allows you to do these tasks:

- Adjust print settings. (Printing using special features is not supported.)
- Specify the default printer from your DOS program.
- Set the symbol set for the language you are using in a document.

Note that changes made to settings in your DOS program may override changes made to the same settings in the DJCP.

To install DJCP

1. Make sure the printer is set up and that the printer is turned on.
2. Insert the Starter CD into the CD drive.
3. At the DOS prompt, type the letter of the CD drive and press ENTER. For example, type D: and press ENTER.
4. Change to the directory to drivers\dos\<language>\, where <language> is the language you prefer, and press ENTER.
5. Type install and press ENTER.
6. Follow the instructions on the screen to complete the installation.
This section provides information about maintaining the printer and troubleshooting common printer problems, such as paper jams and poor quality printing.

- If you know you need to replace an ink cartridge or printhead, or clean the printheads, see "Maintaining ink cartridges and printheads".
- If you know that the colors do not appear as they should, see "Calibrating color".
- If you need to clear a jam, see "Clearing jams".
- If you have any other usage problem, see "Starting troubleshooting".
- If you had trouble installing the printer, see "Troubleshooting installation issues".

### Maintaining ink cartridges and printheads

The ink cartridges should not require maintenance except for replacing them when the ink runs out. The printheads require very little maintenance.

### Replacing ink cartridges

*CAUTION*

The ink in HP ink cartridges has been formulated to ensure superior print quality and compatibility with your printer. Damage to the printer that results from modifying or refilling the ink cartridges, or from using non-HP ink cartridges, is not covered under the warranty.

You do not have to replace all four ink cartridges when one runs out. Only replace the ink cartridge for the color that is low or out.

You can check the ink levels from the Toolbox. You can also check the printer control panel to see if an ink cartridge is low, as shown here.

- The ink cartridge is low on ink when the Ink Cartridge light blinks, and one or more of the color indicator lights is on.
- You can press the (resume button) to continue printing.
- The ink cartridge is out of ink when the Ink Cartridge light, one or more of the color indicator lights, and the Resume light are on.
- You must replace the ink cartridge to continue printing.
To replace an ink cartridge

1. Turn the printer power on, and then lift the printing supplies cover.

2. Remove the ink cartridge that requires replacement by grasping it between your thumb and forefinger and pulling it firmly toward you.

3. Insert the new ink cartridge into its own color-coded slot.

4. Press down firmly on the new cartridge to ensure proper contact after installation.

5. Close the printing supplies cover.
Checking the printheads

If the Toolbox is installed on a computer running Windows, you can check the health of the printheads. Replace the printheads when print quality degrades. You can also check the quality by printing a printer configuration page. See “Printing a configuration page”.

To check the printheads from the Toolbox

1. Open the Toolbox.
2. On the Information tab, click Printhead Health.
3. Check the status of each of the printheads.
4. If the status of one or more printheads is listed as Bad, replace the printhead. See “Replacing the printheads”.

To check the printheads using a printer configuration page

Print a printer configuration page by holding down the (power button) and pressing the (cancel button) on the printer once. Release the (power button).

Cleaning the printheads

CAUTION

HP is not responsible for damage to the printer that results from modifying the printheads.

If the printed characters are incomplete, or if dots or lines are missing from the printouts, you might need to clean the printheads. This is a symptom of clogged ink nozzles, which are a result of prolonged exposure to air.

Clean the printheads from the Toolbox (Windows) or the HP Inkjet Utility (Mac OS). Or, follow the procedures below for cleaning the printheads from the control panel.

There are three cleaning levels available. Run the level 1 cleaning. Only run the level 2 cleaning if the results of the first cleaning were unsatisfactory. Similarly, only run the level 3 cleaning if the results of the second cleaning were unsatisfactory.

Note

Only clean the printheads when necessary; cleaning the printheads uses ink and shortens the life of the printheads.

To clean the printheads from the Toolbox

1. Open the Toolbox.
2. Click the Printer Services tab.
3. Click Clean Printheads and follow the instructions on the screen.

To clean the printheads from the HP Inkjet Utility

1. Open the HP Inkjet Utility.
2. Click Clean and follow the instructions on the screen.
To perform a level 1 printhead cleaning at the control panel

1. Press and hold down the \( \text{ } \) (power button).
2. While holding down the \( \text{ } \) (power button), press the \( \text{ } \) (cancel button) twice.
3. Release the \( \text{ } \) (power button). The printer begins the printhead cleaning process.
4. Print a printer configuration page by holding down the \( \text{ } \) (power button) and pressing the \( \text{ } \) (cancel button) once. Release the \( \text{ } \) (power button).
5. If the results are satisfactory, the process is finished. If not, perform a level 2 printhead cleaning.

To perform a level 2 printhead cleaning at the control panel

Note

Only perform a level 2 printhead cleaning if the level 1 cleaning was insufficient.

1. Press and hold down the \( \text{ } \) (power button).
2. While holding down the \( \text{ } \) (power button), press the \( \text{ } \) (cancel button) twice and then press the \( \text{ } \) (resume button) once.
3. Release the \( \text{ } \) (power button). The printer begins the printhead cleaning process.
4. Print a printer configuration page by holding down the \( \text{ } \) (power button) and pressing the \( \text{ } \) (cancel button) once. Release the \( \text{ } \) (power button).
5. If the results are satisfactory, the process is finished. If not, perform a level 3 printhead cleaning.

To perform a level 3 printhead cleaning at the control panel

Note

Only perform a level 3 printhead cleaning if the level 2 cleaning was insufficient.

1. Press and hold down the \( \text{ } \) (power button).
2. While holding down the \( \text{ } \) (power button), press the \( \text{ } \) (cancel button) twice and then press the \( \text{ } \) (resume button) twice.
3. Release the \( \text{ } \) (power button). The printer begins the printhead cleaning process.
4. Print a printer configuration page by holding down the \( \text{ } \) (power button) and pressing the \( \text{ } \) (cancel button) once. Release the \( \text{ } \) (power button).
5. If the results are not satisfactory, replace the printheads, if you want.
Cleaning the printhead contacts

If lines or dots are still missing from printed text or graphics after you have cleaned the printheads, the printhead contacts might be dirty.

CAUTION
HP recommends that you clean the printhead contacts only after you have cleaned the printheads. Printhead contacts contain sensitive electronic components that can be damaged easily.

To clean the printhead contacts

1. Turn the printer power on, and then lift the printing supplies cover.

2. Open the printhead access latch by lifting the latch from the rear. Pull the latch forward and down to release the hook from the carriage lock.

3. Pull the latch up and back to uncover the printheads.
4 Lift up the handle of the printhead and use it to pull the printhead straight up and out of its slot.

5 Using a soft, dry, lint-free cloth, carefully remove any ink from the contact pads on the printhead and inside the printhead slot in the printer.

6 Reinsert the printhead into its color-coded slot. Press down firmly on the printhead to ensure proper contact after installation.

7 Repeat steps 4 through 6 for the remaining printheads.

8 Close the printhead access latch firmly, ensuring the hook catches the carriage lock, and then close the printing supplies cover. You will need to use some force to close the printhead access latch.
Aligning the printheads

Whenever you replace a printhead, the printer automatically aligns the printheads for the best possible quality. However, if the appearance of your printed pages indicates that the printheads are misaligned, you can align them from the control panel, from the Toolbox (Windows), or from the HP Inkjet Utility.

To align printheads from the control panel

Hold down the (power button) and press the (resume button) three times.

To align the printheads from the Toolbox (Windows)

1. Click Start, point to Programs, point to hp business inkjet 1100 series, and click hp business inkjet 1100 series Toolbox.
2. On the Services tab, click Align Printheads and click Align.
3. When the alignment procedure is complete, click OK to close the Align Printheads dialog box.

To align the printheads from the HP Inkjet Utility (Mac OS)

1. Open the HP Inkjet Utility and click Calibrate Device. An alignment page prints.
2. Follow the instructions on the screen to select the best-aligned pattern from the printed page.
Replacing the printheads

You do not have to replace all four printheads when one needs to be replaced. Only replace the color of printhead indicated.

You can check the status of the printheads from the Toolbox. You can also check the printer control panel to see if a printhead needs to be replaced, as shown here.

The printhead needs to be replaced when the Printhead light and a color indicator light are on. The Resume light is also on.

You must replace the printhead to continue printing.

To replace a printhead

1. Turn the printer power on, and then lift the printing supplies cover.

2. Open the printhead access latch by lifting the latch from the rear. Pull the latch forward and down to release the hook from the carriage lock.

3. Pull the latch up and back to uncover the printheads.
4 Lift up the handle of the printhead and use it to pull the printhead straight up and out of its slot.

5 Install the new printhead in the color-coded slot that matches the color of the printhead.

6 Press down firmly on the printhead to ensure proper contact after installation.

7 Close the printhead access latch firmly, ensuring the hook catches the carriage lock, and then close the printing supplies cover. You will need to use some force to close the printhead access latch.
Calibrating color

The printer automatically calibrates color when you change a printhead. Calibrate color manually, as described here, when you are not satisfied with the appearance of the colors. If you are running Windows, calibrate color from the Toolbox. If you are running the Mac OS, calibrate color from the HP Inkjet Utility.

To calibrate color from the Toolbox

1. Click the Toolbox icon on your desktop to open the Toolbox.
2. On the Printer Services tab, click Calibrate Color and follow the directions.

To calibrate color from the HP Inkjet Utility

1. Open the HP Inkjet Utility and click Calibrate Color.
2. Follow the instructions on the screen.
Clearing jams

If the print media is jammed in the printer, follow these instructions to clear the jam.

To clear a jam

Note

Information about Tray 2 is only applicable if you have an HP Business Inkjet 1100dtn or you purchased this accessory.

1. Remove all media from the output tray.
2. Check the auto-duplex unit.
   a. Push the button on either side of the auto-duplex unit and remove the unit.
   b. If you locate the jammed media inside the printer, grasp it with both hands and pull it towards you.
   c. If the jam is not there, push the latch on the top of the auto-duplex unit and lower its cover. If the jam is inside, carefully remove it. Close the cover.
   d. Reinsert the auto-duplex unit into the printer.
   e. If you cannot locate the jam in the auto-duplex unit, go to step 3.
3 Lift the output tray and check for a jam in Tray 1.
   a If the media is jammed in Tray 1, pull out Tray 1. (Otherwise, go to step 4.)
   b Pull the paper towards you as shown in the diagram.
   c Lower the output tray and reposition Tray 1.

4 If you have not yet found the jam and have Tray 2 installed, pull out Tray 2. (Otherwise, go to step 5.)
   a If possible, remove the jammed media from Tray 2.
   b If you cannot locate the jammed media by removing Tray 2 from the printer, turn off the printer (if you have not already done so), and then remove the power cord.
   c Lift the printer off Tray 2.
   d Remove the jammed media from the bottom of the printer or from Tray 2.
   e Reposition the printer on top of Tray 2.

5 Open the top cover and look inside to ensure there is no paper remaining inside the printer. If there is paper inside the printer, follow the steps listed here. Otherwise, go to step 6.
   a When you lift the top cover, the carriage should return to its position on the right side of the printer. If the carriage does not return to the right side, turn the printer off.

WARNING! Do not reach into the printer when the printer is on and the carriage is stuck.
   b Free any wrinkled media and pull the sheet towards you through the top of the printer.

6 After you clear the jam, close all covers, turn on the printer (if you turned it off), and then press the (resume button) to continue the print job.

The printer will continue the print job on the next page. You will need to resend the page or pages that were jammed in the printer.

To avoid jams
- Make sure that nothing is blocking the paper path.
- Do not overload the trays. Tray 1 holds up to 150 sheets of plain paper or 30 transparencies. Tray 2 holds up to 250 sheets of paper. The envelope slot holds one envelope.
- Load paper properly. See “Loading media”.
- Do not use media that is curled or crumpled.
- Always use media that conforms with specifications listed in “Selecting print media”.
- Make sure that the output tray is not overly full when you send a job to print.
- Be sure to align the media against the right side of the tray and the front guide.
- Verify that the guides are adjusted snugly against the stack, but that they do not crinkle or bend it.
Starting troubleshooting

Start in this section if you are having a problem with the printer.

- If you have a jam, see “Clearing jams”.
- If you have a different type of paper-feed problem, such as the paper is skewing, it is not being picked up, or you cannot reinsert a tray into the printer, see “Resolving paper-feed problems”.
- Otherwise, if the printer is not working properly or if the print quality is not what you expect, try the following steps first.
  - Check that the power cord is securely connected to the printer and plugged into a live electrical outlet.
  - Check that the Power (green) light is on and not blinking. When the printer is first turned on, it takes approximately 45 seconds to warm up.
  - Check that no other lights on the control panel are on or blinking. If lights are on or blinking, see “Printer lights reference”.
  - Check that you can print a printer configuration page. See “Printing a configuration page”.
  - Check that the USB or parallel cable between the printer and the computer or the HP Jetdirect print server is connected securely and functioning properly. To check the network connection, press the TEST button on the print server. An HP Jetdirect configuration page should print. See the HP Jetdirect Print Server Administrator’s Guide that came on the Starter CD to interpret the messages on the page.
  - Check that no error messages appear on the computer screen.
  - Check that you do not have too many programs open when you’re trying to perform a task. Close programs that are not in use, or restart the computer before attempting the task again.

After you have tried these steps, see the following sections for information about more specific problems:

- Resolving printer problems
- Resolving printing problems (includes print-quality issues)
- Resolving paper-feed problems (including skewing)

If none of these suggestions solve the problem, see “Support and warranty”.

**Note**

For more information about how to troubleshoot Macintosh printing problems, see the Mac Readme file on the Starter CD.
Printing a configuration page

When you are experiencing a problem with your printer and you cannot discover the source of the problem, you can print a printer configuration page that provides more information about the problem. You can print the printer configuration page from the control panel. If you are using a computer that is running Windows, you can also print the printer configuration page from the Toolbox. If you have an HP Jetdirect print server installed, you can print a printer configuration page for the print server as well.

If you still cannot resolve the problem after reviewing the printer configuration page and trying the steps in the troubleshooting section, call the HP Customer Care Center. Keep the printer configuration page, because it provides information that might be useful to Customer Care Center in helping you to troubleshoot a printer problem.

To print a printer configuration page from the control panel

1. Turn the printer on.
2. Press and hold down the (power button). While holding down the (power button), press the (cancel button) one time.
3. Release the (power button). Your printer prints a printer configuration page.

To print a configuration page for the HP Jetdirect print server

1. Turn the printer power on, and then press the TEST button on the print server. The printer prints a configuration page for the HP Jetdirect print server.
2. See the HP Jetdirect Administrator’s Guide on the Starter CD to interpret the information on the configuration page.
Resolving printer problems

This section provides solutions to common problems that involve the operation of the printer.

**Printer shuts down unexpectedly**

*Check the power*

- Make sure the power cord is connected firmly to the printer and to a working outlet, and that the printer is turned on. The Power light on the control panel of the printer should be green. Try turning the printer off, and then on again.
- When the printer is first turned on, it takes approximately 45 seconds to warm up. Wait for the printer to warm up.

*Check the printer vents*

- The printer vents are located on the left side of the printer. If the printer vents are covered and the printer overheats, it automatically turns off. Make sure the vents are not covered and the printer is in a cool, dry location.

**Printer is not responding (nothing prints)**

If you tried to print when the printer was off, an alert message should have appeared on your computer screen. If the printer was off and you did not see a message when you tried to print, the printer setup might be incorrect. To correct this problem, reinstall the software that came with your printer.

*Check the power*

- Make sure that the printer power is on. To turn the printer power on, press and hold the \( \text{power button} \) on the printer for a few seconds. After a brief printer startup, you should see a steady green light on the corner of the button.
- When the printer is first turned on, it takes approximately 45 seconds to warm up. Wait for the printer to warm up.

*Check the connections*

- Make sure that the power cord is securely connected from your printer to a working outlet. If you still cannot turn the printer on, you might have a faulty power cord or control panel. Unplug the printer and call the HP Customer Care Center. See “Support and warranty”.
- Make sure that both ends of the cable (USB or parallel) are secure.
Check the printer setup

- Check that the ink cartridges, and printheads are loaded correctly. Make sure that all the tape has been removed from the printheads.
- Check that the top cover and printing supplies cover are closed.
- Make sure media is loaded correctly in the tray and that the media is not jammed in the printer.
- Check to make sure that your printer is selected as the current or default printer and that Pause Printing is not selected. The default printer is the one that is used if you choose the Print command without first specifying which printer you want to use with an application. The default printer should be the printer that you use most often.

If the printer selection is a problem, open the Printers folder in Windows and set this printer as the default. In the Mac OS, set this printer as the default in the Chooser or the Print Center.

Make sure that your printer is properly set up in your network environment.

- For example, make sure that the correct printer driver is being used and that the correct printer driver port has been set. For more information about network connections, see “Connecting to a network” or the documentation provided by your network vendors.

All lights are blinking

A non-recoverable error has occurred

- For example, the printhead carriage might be jammed. Try turning the printer off and then on again. If the printer does not recover, unplug the printer from the power outlet and call HP Customer Support. See “Support and warranty”.

Printer takes a long time to print

Check your system configuration

- Make sure that your computer meets the minimum system requirements for the printer. See “System requirements”.

Check your port setting

- The port setting configuration in your system might not be set to ECP.

See the manual that came with your computer for information about how to change your port setting, or contact your computer manufacturer.

Check the settings

- If the Type is set to Transparencies, or if the AutoSelect Type setting determines that you are printing transparencies, or if you chose Best mode, then printing will take longer. If you want these settings to be used, wait for the printer to finish. Otherwise, change the settings in the driver and print again.
Resolving printing problems

This section provides solutions to common printing problems.

A blank page printed

Check that the tape is removed from the printheads
- Each new printhead is packaged with protective plastic film covering the ink nozzles. Check each printhead and remove film if necessary.
- Clean any excess adhesive from the contact area on the backs of the printheads with a clean, lint-free cloth.

Check for empty ink cartridges
- If you are printing black text and a blank page prints, your black ink cartridge might be empty. See “Replacing ink cartridges”.

Check the printer setup
- If the printer selection is a problem, open the Printers folder in Windows and set this printer as the default. In the Mac OS, set this printer as the default in the Chooser or the Print Center.

Check that the media you are using is wide enough
- The media width must match the page settings in your print settings.

Check the parallel port on your computer
- If you are using a parallel cable, make sure your printer is connected directly to the parallel port. Do not share the port with other devices, such as a Zip drive.

Something on the page is missing or incorrect

Check the margin settings
- Make sure that the margin settings for the document do not exceed the printable area of the printer. See “Setting minimum margins”.

Check the color print settings
- Grayscale might be selected in the Print Settings dialog box.
Placement of the text or graphics is wrong

**Check the page-orientation setting**

- The page orientation selected might not be correct for the document you are printing. Make sure the media size and page orientation selected in the application match the settings in the **Print Settings** dialog box. See “Changing printer settings”.

**Check the paper size**

- The **Paper Size** setting might not match the size of media you are using. Select the correct paper size from the printer driver.
- Some of the content might be missing or cut off if the document size is larger than the media loaded in the tray.
  
  If the layout of the document you are trying to print will fit on a media size supported by the printer, then load the correct media size. Make sure to select the correct page orientation.
  
  Alternatively, select **Emulate LaserJet Margins** in the printer driver to scale the document to fit the media size currently selected.

**Check the margin settings**

- If the text or graphics are cut off at the edges of the page, make sure that the margin settings for the document do not exceed the printable area of your printer. See “Setting minimum margins”.

**Check how the media is loaded**

- Make sure that the width and length guides fit snugly against the left and bottom edges of the stack of media. For Tray 1, make sure that the tray contains no more than 150 sheets of media or a stack no thicker than 0.58 inch (15 mm). For Tray 2, make sure it contains no more than 250 sheets of media or a stack no thicker than 0.98 inch (25 mm). See “Loading media”.

If none of the above solutions worked, the problem is likely caused by the inability of the application to interpret print settings properly. Check the release notes for known software conflicts. Otherwise, check your application manual, or call the software manufacturer for more specific help for this problem.
Poor print quality
First try these general steps when you see poor print quality.

**Check the printheads and ink cartridges**
- Replace any clogged or worn printheads or low or empty ink cartridges (See “Maintaining ink cartridges and printheads”.) Then try to print again.

**Check the paper quality**
- The paper might be too moist or too rough. Make sure that the media you are using meets HP specifications. (See “Selecting print media”.) Then try to print again.

**Check the rollers that are inside of the printer**
- The rollers inside of the printer might be dirty, causing lines or smudges to appear on your printout. Turn off the printer, unplug the power cord, and clean the rollers inside of the printer with isopropyl alcohol on a lint-free cloth. Then try to print again. (Some printers might have a certain amount of aerosol on the inside wall after prolonged use. This should not cause lines or smudges on printouts.)

See the next sections for more specific problems:
- Meaningless characters print
- Ink is smearing
- Ink is not filling the text or graphics completely
- Output is faded or dull colored
- Colors are printing as black and white
- Wrong colors are printing
- Printout shows bleeding colors
- Colors do not line up properly
- Lines or dots are missing from text or graphics

**Meaningless characters print**

**Check the cable connection**
- A common cause for meaningless characters is a poor cable connection between the printer and computer. Make sure that the cable connection at both ends is good and that the cable is securely fastened.
- If you are using a parallel cable or USB cable and the problem persists after you have checked the connection, turn off the printer and disconnect the cable from the printer. Turn the printer back on without the connection in place. When the Power light is on and not flashing, reconnect the cable.

**Check the document file**
- Occasionally, a document file is damaged. If you can print other documents from the same application, try to print using a backup copy of your document, if available.

**Check the symbol set**
- If you are using DOS, use the DJCP to set the appropriate symbol set for the language of your document.

**Cancel the job**
- After an interruption has occurred to a job that is printing, the printer might not recognize the rest of the job. Cancel the current job and wait for the printer to return to the Ready state. If the printer does not return to the Ready state, cancel all job processes and wait again. When the printer returns to the Ready state, resend the job. If prompted at the computer to retry the job, click **Cancel**.
Ink is smearing

**Check the print mode**
- When you print documents that use a lot of ink, you must allow the document more time to dry before handling it. This is especially true for transparencies. Select **Best** mode in the printer driver, and increase the ink drying time from **Advanced Features** in the printer driver. Under **Advanced Features** is an **Ink Volume** slider that you can use in conjunction with drying time to decrease ink saturation. However, note that decreasing ink saturation might give printouts a "washed-out" quality.
- Color documents that have rich, blended colors can wrinkle or smear when printed using **Best** mode. Try using the **Normal**, **Fast Normal**, or **Draft** mode to reduce ink, or use HP Premium Paper designed for printing vivid color documents.

**Check the media type**
- Some types of media do not accept ink well, which causes the ink to dry more slowly and results in smearing. See "Selecting print media".

Ink is not filling the text or graphics completely

**Check the ink cartridges**
- Try removing and then reinstalling the ink cartridges, and make sure to snap them firmly into place.
- Your ink cartridge might be out of ink. Replace the empty ink cartridge. See “Replacing ink cartridges”.

**Check the media type**
- Some media types are not suitable for use with your printer. See “Selecting print media”.

Output is faded or dull colored

**Check the print mode**
- The **Fast Normal** and **Draft** modes allow you to print at a faster rate. This option is good for printing drafts. To achieve better colored printout, select **Normal** or **Best** mode in the printer driver.

**Check the paper type print setting**
- When printing on transparencies or other special media, select the corresponding media type in the **Print Settings** dialog box.

**Check the ink cartridges**
- On the printed page, check that all the lines in the text or image are connected and have printed properly. If the lines are broken, one or more of your ink cartridges is probably out of ink or defective. Replace those ink cartridges with new ones.

Colors are printing as black and white

**Check the printer driver settings**
- The **Print In Grayscale** check box might be selected. From your application, open the **Printer Properties** dialog box. Click the **Color** tab and make sure **Print in Grayscale** is not selected.
Wrong colors are printing

Check the printer driver settings
- The Print In Grayscale check box might be selected. From your application, open the Printer Properties dialog box. Click the Color tab and make sure that Print in Grayscale is not selected.

Check the ink cartridges
- When colors are completely wrong, the printer might have run out of one or more colors of ink. Check the status of the ink cartridges in the Toolbox or on the control panel, and then replace any low or empty ink cartridges. See “Replacing ink cartridges”.

Check the printheads
- Whenever print quality noticeably decreases, it is a good idea to clean the printheads. To clean the printheads, open the Toolbox, click the Printer Services tab, and then click Clean Printheads. For Macintosh, use the control panel. See “Maintaining ink cartridges and printheads”.

Printout shows bleeding colors

Check the print settings
- Some media type settings (such as Transparency Films and Photo Papers) and print quality settings (such as Best) require more ink than others. Choose different print settings in the Print Settings dialog box. Also, make sure that you have selected the correct media type in the Print Settings dialog box.

Check the ink cartridges
- Make sure that the ink cartridges have not been tampered with. Refilling processes and the use of incompatible inks can disrupt the intricate printing system and result in reduced print quality and damage to the printer. HP does not guarantee or support refilled ink cartridges. For ordering HP supplies and accessories, see “HP supplies and accessories”.

Colors do not line up properly

Check the printheads
- The printheads on your printer are automatically aligned when a printhead is replaced. However, you might notice print quality improvement by performing the alignment procedure yourself. See “Aligning the printheads”.

Check the graphics placement
- Use the zoom or print preview feature of your software to check for gaps in the placement of graphics on the page.

Lines or dots are missing from text or graphics

Check the printheads
- The printheads or printhead contact pads might need cleaning. See “Maintaining ink cartridges and printheads”.
Resolving paper-feed problems

This section provides solutions to common paper-feed problems.
For information on resolving jams, see “Clearing jams”.

Tray cannot be inserted

- With the tray removed from the printer, turn the printer off and then on again. Reinsert the tray.
- Make sure that the tray is aligned with the printer opening.

Another paper-feed problem is occurring

*Media is not supported for the printer or tray*

- Make sure that you are using media that is supported for the printer and for the tray being used. (See “Printer specifications” and “Understanding specifications for supported media”.)

*Media is not picked up from Tray 1 or Tray 2*

- Check that the guides are set to the correct marking in the trays for the size of paper you are loading. Also make sure the guides are snug, but not tight, against the stack.
- Make sure the media you are using is not curled. Uncurl paper by bending it in the opposite direction of the curl.
- Make sure that the tray has been pushed completely into the printer.

*An envelope is not picked up from the envelope slot*

- Make sure that there is not more than one envelope loaded in the envelope slot.
- Make sure that the envelope is not wrinkled or bent. Do not leave an envelope in the envelope slot overnight because doing so can cause the envelope to bend.
- Make sure that media in Tray 1 is not interfering with the envelope slot and causing more than one envelope to be fed. Remove any media from Tray 1 and try again.

*Media is not coming out correctly*

- If the output tray extension is not extended, output pages will fall off the printer. Make sure that output tray extension is extended.
- Remove excess media from the output tray. The output tray is designed to hold a maximum of 100 sheets at a time.
- If the auto-duplex unit is not installed or if the auto-duplex unit door is down during a duplex job, media will exit the rear of the printer. Reinstall the auto-duplex unit or close the auto-duplex unit door.

*Pages are skewing*

- Make sure that media loaded in Tray 1 or Tray 2 is aligned to the right and front guides.
Multiple pages are being picked up

- Make sure that the stack of paper has been aligned with the right and front guides.
- Make sure that the tray has not been overloaded with paper.
- When you load paper, avoid fanning the stack. Fanning paper can cause static electricity to build up and intensify multiple-pick problems.
- When you reinsert a tray in the printer, make sure that you insert it gently. Forceful insertion with a full stack of paper can cause sheets to slide up within the printer, causing the printer to jam or pick multiple sheets at one time.

Troubleshooting installation issues

If you had trouble installing the printer, check these items.

Hardware installation issues

- Make sure the power supply cord is connected securely to the printer. Make sure that the power cord is connect securely between the power supply and a working power outlet.
- Make sure that all packing tape has been removed from the outside and inside the printer.
- Make sure that the auto-duplex unit has been installed. The printer cannot work properly without the auto-duplex unit installed.
- Make sure that all of the printheads and ink cartridges are installed.
- Make sure the printheads and ink cartridges are installed properly. The printer cannot work if they are not installed.
  - Make sure that you have removed the tape from the printheads.
  - Make sure that all of the printheads are in their correct, color-coded slot.
  - Make sure that all of the ink cartridges are in their correct, color-coded slot.
  - Make sure that all of the printheads and ink cartridges are firmly installed into their slots. Press down firmly on each one to ensure proper contact.
- Make sure that the printhead latch is closed properly.
- Make sure that the printer is loaded with paper.
- Make sure no lights are on or blinking except the Power light, which should be on. If any other lights are on, see “Printer lights reference” to interpret the light pattern.
- Make sure that the printer can print a printer configuration page. Press and hold down the (power button). While holding down the (power button), press the (cancel button) one time. Release the (power button). The printer configuration page should print.
- Make sure that any printer cable you are using is in good working order and that it is securely connected between the appropriate connector on the printer and the computer or a network connection.
Software installation issues

- Make sure your computer is running one of these operating systems: Windows 98, 2000, NT 4.0, Me, or XP. If you are using a Macintosh, it must be running Mac OS 8.6 or later.
- Make sure the computer meets at least the minimum system requirements listed here.
  - Minimum
    - Windows 98: Pentium® 90 MHz, 16 MB RAM, 60 MB hard disk space
    - Windows NT 4.0: Pentium 100 MHz, 32 MB RAM, 60 MB hard disk space
    - Windows Me: Pentium 150 MHz, 32 MB RAM, 60 MB hard disk space
    - Windows 2000: Pentium 300 MHz, 64 MB RAM, 60 MB hard disk space
    - Windows XP, 32 bit: Pentium 233 MHz, 64 MB RAM, 60 MB hard disk space
    - Mac OS 8.6 or later: 32 MB RAM

  To view the CHM file (Windows), you must be running Internet Explorer 4.0 or later.

  - Recommended
    - Windows 98, Windows Me: Pentium 266 MHz, 32 MB RAM, 100 MB hard disk space
    - Windows NT 4.0: Pentium 266 MHz, 64 MB RAM, 100 MB hard disk space
    - Windows 2000: Pentium 300 MHz, 64 MB RAM, 100 MB hard disk space
    - Windows XP, 32 bit: Pentium 300 MHz, 128 MB RAM, 100 MB hard disk space
    - Mac OS 8.6 or later: 100 MB RAM

  To view the CHM file (Windows), you must be running Internet Explorer 4.0 or later.

- Before installing software on a Windows computer, make sure that all other programs in the Task Manager are closed.
- If the computer does not recognize the path that you type to the CD, make sure you are specifying the correct drive letter on the computer.
- If the computer cannot recognize the CD in the CD drive, inspect the CD for damage. You can download the printer driver from http://www.hp.com/support/businessinkjet1100.
The printer LEDs (or lights) indicate printer status and are useful for diagnosing printing problems. This chapter provides a list of LED status light combinations, what they indicate, and how to solve the problem.

### 1 Power button
### 2 Printhead light
### 3 Ink cartridge light
### 4 Power light
### 5 Color indicator lights
### 6 Cancel button
### 7 Resume button
### 8 Resume light

<table>
<thead>
<tr>
<th>Light pattern</th>
<th>Light description</th>
<th>Explanation and recommended action</th>
</tr>
</thead>
<tbody>
<tr>
<td>No lights are on.</td>
<td>The printer is off.  ● Press the (power button).</td>
<td></td>
</tr>
<tr>
<td>The Power light is on.</td>
<td>The printer is ready.  ● No action is required.</td>
<td></td>
</tr>
<tr>
<td>The Power light blinks.</td>
<td>The printer is turning on or off or processing a print job, or a print job has been cancelled.  ● No action is required.</td>
<td></td>
</tr>
<tr>
<td>Light pattern</td>
<td>Light description</td>
<td>Explanation and recommended action</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------</td>
<td>-----------------------------------</td>
</tr>
</tbody>
</table>
| ![Power light on and Resume light blinks.](image) | The Power light is on and the Resume light blinks. | The printer is out of paper.  
- Load paper and then press the (resume button).  
The printer is in manual duplex mode. It is waiting for the ink to dry so the pages can be flipped over and reloaded.  
- Reload the stack into the printer and press the (resume button).  
The printer is pausing for the ink to dry.  
- Wait for the ink to dry. The Resume light will stop blinking.  
The printer has printed a banner, and the banner needs to be removed from the printer.  
- Press the (resume button) to remove the banner from the printer.  
The auto-duplex unit is not installed. The printer cannot print without it installed.  
- Install the auto-duplex unit, and then press the (resume button).  |
| ![Power light and Resume light blink.](image) | The Power light and Resume light blink. | Print media is jammed in the printer.  
- Press the (resume button) to eject the jammed media.  
- Remove all media from the output tray. Open the top cover to locate the jam. After clearing the jam, press the (resume button) to continue the print job.  |
| ![Power light blinks and Resume light is on.](image) | The Power light blinks and the Resume light is on. | One or more covers on the printer are open.  
- Close any open covers.  
- Make sure the auto-duplex unit is properly installed.  
A printer error has occurred.  
- Turn the printer off and then on again.  |
| ![Power light blinks and Printhead and Resume light are on.](image) | The Power light blinks and the Printhead and Resume light are on. | The printhead latch is not secured.  
- Open the printing supplies cover and secure the printhead latch.  |
| ![Printhead light, a color indicator light, and the Resume light are on.](image) | The Printhead light, a color indicator light, and the Resume light are on. | One or more of the printheads needs attention.  
- Reinstall the printheads and try to print.  
- Try cleaning the printhead contacts. See “Cleaning the printhead contacts”.  
- If the error persists, replace the printhead or printheads indicated.  |
<table>
<thead>
<tr>
<th>Light pattern</th>
<th>Light description</th>
<th>Explanation and recommended action</th>
</tr>
</thead>
</table>
| ![Ink Cartridge light, color indicator light, and Resume light on.](image) | One or more of the ink cartridges needs attention.  
- Reinstall the ink cartridges and try to print.  
- If the error persists, replace the ink cartridge or cartridges indicated. | |
| ![Ink Cartridge light blinks, color indicator lights, and Resume light on.](image) | An ink cartridge is low on ink and will need to be replaced soon.  
- Press the (resume button) to continue printing. | |
| ![Ink Cartridge light, color indicator lights, and Resume light on.](image) | An ink cartridge is out of ink and must be replaced before you can continue printing.  
- Replace the ink cartridge indicated. | |
| ![Ink Cartridge light is on and a color indicator light and Resume light blink.](image) | A non-HP ink cartridge is installed.  
**CAUTION:** Damage to the printer that results from modifying or refilling the ink cartridges, or from using non-HP ink cartridges, is not covered under the warranty.  
- If you thought that this ink cartridge was an HP ink cartridge, return it to the place where you purchased it. Buy and install an HP ink cartridge.  
- If you choose to use a non-HP ink cartridge, press and hold down the (power button) and press the (resume button) three times. Release the (power button). All lights except the Power light go off. Damage that results to the printer from using this cartridge is not covered under the warranty. | |
| ![Printhead light and color indicator light on.](image) | The printer detects a faulty printhead.  
- Replace the printhead indicated. | |
| ![Ink Cartridge light and color indicator light on.](image) | The printer detects a faulty ink cartridge.  
- Replace the ink cartridge indicated. | |
The Printhead light and a color indicator light blink alternately with an Ink Cartridge light and a color indicator light. The Resume light is on.

The printer detects a faulty ink cartridge and a faulty printhead.
- Replace the applicable printheads and ink cartridges.

The Power light, Printhead light, Ink Cartridge light, and Resume light all blink.

Multiple printer errors have occurred.
- Turn the printer off, and then on again.
- If the printer still shows an error, turn the print off, and unplug it. Wait a minute and then turn on the printer again. If the printer error has cleared, send the job again.
- If these measures do not work, see “Support and warranty”.

<table>
<thead>
<tr>
<th>Light pattern</th>
<th>Light description</th>
<th>Explanation and recommended action</th>
</tr>
</thead>
<tbody>
<tr>
<td>alternates with</td>
<td>The Printhead light and a color indicator light blink alternately with an Ink Cartridge light and a color indicator light. The Resume light is on.</td>
<td>The printer detects a faulty ink cartridge and a faulty printhead.</td>
</tr>
<tr>
<td></td>
<td>The Power light, Printhead light, Ink Cartridge light, and Resume light all blink.</td>
<td>Multiple printer errors have occurred.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Turn the printer off, and then on again.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- If the printer still shows an error, turn the print off, and unplug it. Wait a minute and then turn on the printer again. If the printer error has cleared, send the job again.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- If these measures do not work, see “Support and warranty”.</td>
</tr>
</tbody>
</table>
You can order HP supplies and accessories from the HP website. Visit HPshopping.com (http://www.hpshopping.com) for more information. You can also order printing supplies using the Toolbox.

**Ordering printing supplies through the Toolbox**

The three requirements to use this feature are listed here.

- The Toolbox must be installed on your computer (supported for Windows only).
- The printer must be connected to your computer using either a USB cable or a parallel cable, or it must be connected to the network.
- You must have access to the Internet.

**To order printing supplies through the Toolbox**

1. In the status area of the Windows taskbar (near the clock), double-click the Toolbox icon.
2. On the Printer Status tab, click Order Supplies. Your default browser opens and displays a website from which you can purchase printing supplies.
3. Follow the instructions on the website to select and order printing supplies.

**Finding accessory part numbers**

You can order the following accessories for HP Business Inkjet 1100 series printers.

**Paper handling accessories**

<table>
<thead>
<tr>
<th>Accessory Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>250-sheet input tray (Tray 2; included with the HP Business Inkjet 1100dtn.)</td>
<td>C8236A</td>
</tr>
</tbody>
</table>

You can only install one Tray 2 at a time.

**Parallel connector and cables**

<table>
<thead>
<tr>
<th>Connector/Cable Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parallel port connector</td>
<td>C6436-67004</td>
</tr>
<tr>
<td>HP IEEE-1284 A-B Parallel Cable (2 meter)</td>
<td>C2950A</td>
</tr>
<tr>
<td>HP IEEE-1284 A-B Parallel Cable (3 meter)</td>
<td>C2951A</td>
</tr>
</tbody>
</table>

**USB cable**

<table>
<thead>
<tr>
<th>Cable Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP USB A-B (2 meter)</td>
<td>C6518A</td>
</tr>
</tbody>
</table>
Network interfaces

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Jetdirect 200m print server/Internet connector (LIO module; Fast Ethernet; included with the HP Business Inkjet 1100dtn)</td>
</tr>
<tr>
<td>HP Jetdirect 250m print server/Internet connector (LIO module; Fast Ethernet)</td>
</tr>
<tr>
<td>HP Jetdirect 280m print server/Internet connector (LIO module; 802.11b Wireless Ethernet)</td>
</tr>
<tr>
<td>HP Jetdirect 175X external print server via USB (Fast Ethernet)</td>
</tr>
<tr>
<td>HP Jetdirect 310X external print server via USB (Fast Ethernet)</td>
</tr>
</tbody>
</table>

Finding supplies part numbers

All of the following supplies work with all models of the HP Business Inkjet 1100 series printers.

Ink cartridges

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP No. 10 Black</td>
</tr>
<tr>
<td>HP No. 11 Cyan</td>
</tr>
<tr>
<td>HP No. 11 Magenta</td>
</tr>
<tr>
<td>HP No. 11 Yellow</td>
</tr>
</tbody>
</table>

Printheads

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP No. 11 Black</td>
</tr>
<tr>
<td>HP No. 11 Cyan</td>
</tr>
<tr>
<td>HP No. 11 Magenta</td>
</tr>
<tr>
<td>HP No. 11 Yellow</td>
</tr>
</tbody>
</table>

HP Bright White Inkjet Paper

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>500 sheets Letter (8.5 by 11 inches)</td>
</tr>
<tr>
<td>250 sheets Tabloid (11 by 17 inches)</td>
</tr>
<tr>
<td>500 sheets A4 (210 by 297 mm)</td>
</tr>
</tbody>
</table>

HP Premium Plus Photo Paper

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>20 sheets, glossy Letter (8.5 by 11 inches)</td>
</tr>
<tr>
<td>50 sheets, glossy Letter (8.5 by 11 inches)</td>
</tr>
<tr>
<td>20 sheets, glossy 4 by 6 inches</td>
</tr>
<tr>
<td>20 sheets, matte Letter (8.5 by 11 inches)</td>
</tr>
<tr>
<td>20 sheets, glossy A4 (210 by 297 mm)</td>
</tr>
<tr>
<td>20 sheets, matte A4 (210 by 297 mm)</td>
</tr>
<tr>
<td>HP Premium Photo Paper</td>
</tr>
<tr>
<td>-----------------------</td>
</tr>
<tr>
<td>50 sheets, glossy</td>
</tr>
<tr>
<td>15 sheets, glossy</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>HP Photo Paper</th>
</tr>
</thead>
<tbody>
<tr>
<td>20 sheets, two-sided glossy</td>
</tr>
<tr>
<td>20 sheets, two-sided glossy</td>
</tr>
<tr>
<td>20 sheets, one-sided glossy</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>HP ColorFast Photo Paper</th>
</tr>
</thead>
<tbody>
<tr>
<td>20 sheets, glossy</td>
</tr>
<tr>
<td>20 sheets, glossy</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>HP Photo-Quality Inkjet Paper</th>
</tr>
</thead>
<tbody>
<tr>
<td>25 sheets, two-sided, semi-gloss</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>HP Everyday Photo Paper</th>
</tr>
</thead>
<tbody>
<tr>
<td>100 sheets, two-sided, matte</td>
</tr>
<tr>
<td>25 sheets, two-sided, matte</td>
</tr>
<tr>
<td>25 sheets, two-sided, semi-gloss</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>HP Brochure and Flyer Paper</th>
</tr>
</thead>
<tbody>
<tr>
<td>50 sheets, two-sided, glossy</td>
</tr>
<tr>
<td>50 sheets, matte</td>
</tr>
<tr>
<td>100 sheets, tri-fold, two-sided, glossy</td>
</tr>
<tr>
<td>50 sheets, two-sided, glossy</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>HP Premium Paper</th>
</tr>
</thead>
<tbody>
<tr>
<td>200 sheets</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>HP Premium Inkjet Paper</th>
</tr>
</thead>
<tbody>
<tr>
<td>200 sheets, coated, matte</td>
</tr>
<tr>
<td>100 sheets, coated, heavyweight</td>
</tr>
</tbody>
</table>
## HP Premium Inkjet Transparency Film

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Size</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>20 sheets</td>
<td>Letter (8.5 by 11 inches)</td>
<td>C3828A</td>
</tr>
<tr>
<td>50 sheets</td>
<td>Letter (8.5 by 11 inches)</td>
<td>C3834A</td>
</tr>
<tr>
<td>20 sheets</td>
<td>A4 (210 by 297 mm)</td>
<td>C3832A</td>
</tr>
<tr>
<td>50 sheets</td>
<td>A4 (210 by 297 mm)</td>
<td>C3835A</td>
</tr>
</tbody>
</table>

## HP Premium Plus Inkjet Transparency Film

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Size</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>20 sheets</td>
<td>Letter (8.5 by 11 inches)</td>
<td>C7030A</td>
</tr>
<tr>
<td>50 sheets</td>
<td>Letter (8.5 by 11 inches)</td>
<td>C7028A</td>
</tr>
</tbody>
</table>

## HP Banner Paper

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Size</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>100 sheets</td>
<td>Letter (8.5 by 11 inches)</td>
<td>C1820A</td>
</tr>
<tr>
<td>100 sheets</td>
<td>A4 (210 by 297 mm)</td>
<td>C1821A</td>
</tr>
</tbody>
</table>

## HP Textured Greeting Cards

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Description</th>
<th>Size</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>20 sheets</td>
<td>20 envelopes, felt-textured, ivory/half-fold</td>
<td>Letter (8.5 by 11 inches)</td>
<td>C6828A</td>
</tr>
<tr>
<td>20 sheets</td>
<td>20 envelopes, textured, white/half-fold</td>
<td>Letter (8.5 by 11 inches)</td>
<td>C7019A</td>
</tr>
<tr>
<td>20 sheets</td>
<td>20 envelopes, felt-textured, cream/half-fold</td>
<td>A4 (210 by 297 mm)</td>
<td>C6829A</td>
</tr>
</tbody>
</table>

## HP Photo Greeting Cards

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Description</th>
<th>Size</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 sheets</td>
<td>10 envelopes, half-fold</td>
<td>Letter (8.5 by 11 inches)</td>
<td>C6044A</td>
</tr>
<tr>
<td>10 sheets</td>
<td>10 envelopes, half-fold</td>
<td>A4 (210 by 297 mm)</td>
<td>C6045A</td>
</tr>
</tbody>
</table>

## HP Matte Greeting Cards

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Description</th>
<th>Size</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>20 sheets</td>
<td>20 envelopes, white/quarter-fold</td>
<td>Letter (8.5 by 11 inches)</td>
<td>C1812A</td>
</tr>
<tr>
<td>20 sheets</td>
<td>20 envelopes, white/quarter-fold</td>
<td>A4 (210 by 297 mm)</td>
<td>C6042A</td>
</tr>
<tr>
<td>20 sheets</td>
<td>20 envelopes, white/half-fold</td>
<td>A4 (210 by 297 mm)</td>
<td>C7018A</td>
</tr>
</tbody>
</table>

## HP Iron-on T-shirt Transfers

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Description</th>
<th>Size</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 sheets</td>
<td>(12 transfers per sheet)</td>
<td>Letter (8.5 by 11 inches)</td>
<td>C6049A</td>
</tr>
<tr>
<td>10 sheets</td>
<td>(12 transfers per sheet)</td>
<td>A4 (210 by 297 mm)</td>
<td>C6050A</td>
</tr>
</tbody>
</table>
Support and warranty

The information in this section suggests solutions to common problems. If your printer is not operating properly and those suggestions did not solve your problem, try using one of the following support services to obtain assistance.

**Toolbox**

The Toolbox is available only to Windows users. You must have installed the printer driver through SETUP.EXE. After installing your printer, you can open the Toolbox by clicking **Start**, pointing to **Programs**, pointing to **hp business inkjet 1100 series**, and clicking **hp business inkjet 1100 series Toolbox**.

The **Troubleshooting** tab in the Toolbox provides easy step-by-step solutions to common printing problems. You should be able to resolve most printing problems by stepping through the provided solutions.

**hp instant support**

hp instant support, which is available only to Windows users, is a Web-based tool that provides product-specific services, troubleshooting tips, and information about your printer’s ink and media usage. To open hp instant support, click **hp instant support** on the Toolbox’s **Information** tab.

**Note**

hp instant support Web pages are dynamically created. Do not bookmark this site; always open it from the Toolbox.

**Web**

Visit the HP Business Inkjet website on hp.com for the latest printer software, product, operating system, and support information.

http://www.hp.com/support/businessinkjet1100
HP telephone support

During the warranty period, you may obtain assistance from the HP Customer Care Center. For the number to call, refer to the Support guide that came in the box with your printer.

To assist our Customer Care Center representatives to serve you better, prepare the following information before calling.

1 Print the printer configuration page. See “Maintaining and troubleshooting” for instructions on how to print this page. If the printer does not print, get the following information ready.
   a model number and serial number (located at the back of the printer), such as C8124A or C8135A and SG1881119P
   b printer model (HP Business Inkjet 1100d or 1100dtn)

2 Check the operating system that you are using, such as Windows 98 SE.

3 If the printer is connected to the network, check the network operating system, such as Windows NT Server 4.0.

4 Note how the printer is connected to your system, such as parallel, USB, or network.

5 Obtain the printer driver and version number of the printer software, such as HP Business Inkjet 1100 PCL 3 version 1.0.

6 If you have a problem printing from a particular application, note the application and version number.
Hewlett-Packard limited warranty statement

<table>
<thead>
<tr>
<th>HP product</th>
<th>Duration of Limited Warranty</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software</td>
<td>1 year</td>
</tr>
<tr>
<td>Accessories</td>
<td>1 year</td>
</tr>
<tr>
<td>Ink cartridges</td>
<td>90 days</td>
</tr>
<tr>
<td>Printheads</td>
<td>1 year</td>
</tr>
<tr>
<td>Printer peripheral hardware (see below for details)</td>
<td>1 year</td>
</tr>
</tbody>
</table>

**Extent of limited warranty**

1 Hewlett-Packard warrants to the end-user customer that the HP products specified above will be free from defects in materials and workmanship for the duration specified above, which duration begins on the date of purchase by the customer.

2 For software products, HP’s limited warranty applies only to a failure to execute programming instructions. HP does not warrant that the operation of any product will be uninterrupted or error free.

3 HP’s limited warranty covers only those defects that arise as a result of normal use of the product, and does not cover any other problems, including those that arise as a result of:
   a) Improper maintenance or modification;
   b) Software, media, parts, or supplies not provided or supported by HP; or
   c) Operation outside the product’s specifications.

4 For HP printer products, the use of a non-HP ink cartridge or a refilled ink cartridge does not affect either the warranty to the customer or any HP support contract with the customer. However, if printer failure or damage is attributable to the use of a non-HP or refilled ink cartridge, HP will charge its standard time and materials charges to service the printer for the particular failure or damage.

5 If HP receives, during the applicable warranty period, notice of a defect in any product which is covered by HP’s warranty, HP shall either repair or replace the product, at HP’s option.

6 If HP is unable to repair or replace, as applicable, a defective product which is covered by HP’s warranty, HP shall, within a reasonable time after being notified of the defect, refund the purchase price for the product.

7 HP shall have no obligation to repair, replace, or refund until the customer returns the defective product to HP.

8 Any replacement product may be either new or like new, provided that it has functionality at least equal to that of the product being replaced.

9 HP products may contain remanufactured parts, components, or materials equivalent to new in performance.

10 HP’s Limited Warranty Statement is valid in any country/region where the covered HP product is distributed by HP. Contracts for additional warranty services, such as on-site service, are available from any authorized HP service facility in countries where the product is distributed by HP or by an authorized importer.
Limitations of warranty

TO THE EXTENT ALLOWED BY LOCAL LAW, NEITHER HP NOR ITS THIRD PARTY SUPPLIERS MAKES ANY OTHER WARRANTY OR CONDITION OF ANY KIND, WHETHER EXPRESS OR IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

Limitations of liability

1 To the extent allowed by local law, the remedies provided in this Warranty Statement are the customer’s sole and exclusive remedies.

2 TO THE EXTENT ALLOWED BY LOCAL LAW, EXCEPT FOR THE OBLIGATIONS SPECIFICALLY SET FORTH IN THIS WARRANTY STATEMENT, IN NO EVENT SHALL HP OR ITS THIRD PARTY SUPPLIERS BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, WHETHER BASED ON CONTRACT, TORT, OR ANY OTHER LEGAL THEORY AND WHETHER ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Local law

1 This Warranty Statement gives the customer specific legal rights. The customer may also have other rights which vary from state to state in the United States, from province to province in Canada, and from country/region to country/region elsewhere in the world.

2 To the extent that this Warranty Statement is inconsistent with local law, this Warranty Statement shall be deemed modified to be consistent with such local law. Under such local law, certain disclaimers and limitations of this Warranty Statement may not apply to the customer. For example, some states in the United States, as well as some governments outside the United States (including provinces in Canada), may:

   a Preclude the disclaimers and limitations in this Warranty Statement from limiting the statutory rights of a customer (e.g. the United Kingdom);

   b Otherwise restrict the ability of a manufacturer to enforce such disclaimers or limitations; or

   c Grant the customer additional warranty rights, specify the duration of implied warranties which the manufacturer cannot disclaim, or allow limitations on the duration of implied warranties.

3 FOR CONSUMER TRANSACTIONS IN AUSTRALIA AND NEW ZEALAND, THE TERMS IN THIS WARRANTY STATEMENT, EXCEPT TO THE EXTENT LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT, OR MODIFY, AND ARE IN ADDITION TO, THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THE HP PRODUCTS TO SUCH CUSTOMERS.
## Printer specifications

### Print method
Drop on-demand thermal inkjet printing

### Print speed (Letter/A4)

<table>
<thead>
<tr>
<th></th>
<th>Draft</th>
<th>Fast Normal</th>
<th>Normal</th>
<th>Best</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black Text</td>
<td>23 ppm</td>
<td>7.5 ppm</td>
<td>7.5 ppm</td>
<td>4 ppm</td>
</tr>
<tr>
<td>Mixed Text Color</td>
<td>20 ppm</td>
<td>7 ppm</td>
<td>7 ppm</td>
<td>4 ppm</td>
</tr>
<tr>
<td>Full Page Color*</td>
<td>6.5 ppm</td>
<td>2.5 ppm</td>
<td>1.6 ppm</td>
<td>0.7 ppm</td>
</tr>
</tbody>
</table>

*Plain Paper

### Print speed (laser-quality speed)
Black Text: 4.3 ppm
Mixed Text Color: 4 ppm

### Black and color resolution
Black up to 1200 dpi with pigmented black ink
HP PhotoREt III enhanced color-layering technology or up to 4800 x 1200 optimized dpi available on HP premium photo papers

### Printer languages
HP Business Inkjet 1100d: HP PCL 3 enhanced
HP Business Inkjet 1100dtn: HP PCL 3 enhanced

### Software compatibility
Microsoft Windows 98, Windows Me, Windows NT 4.0, Windows 2000, Windows XP
Mac OS 8.6 or later

### Fonts

### Media size
- **Standard US**: letter, legal, executive, statement, index cards
- **Standard International**: A6, A5, A4
- **Custom US**: 3 by 5 inches wide to 8.5 by 14 inches long
- **Custom Metric**: 76.2 by 127 mm wide to 216 by 356 mm long

### Media type
Paper (plain, inkjet, photo, and banner), envelopes, transparencies, labels, iron-on transfers, greeting cards

### Media handling
Envelope slot, Tray 1, Tray 2 (part C8236A, included with the HP Business Inkjet 1100dtn), output tray

### Recommended media weight
- **Paper**: 16 to 28 lb Bond using Tray 1 or Tray 2
- **Envelopes**: 20 to 24 lb Bond
- **Cards**: 110 lb Index

### Media supported (maximum number of pages supported)
- **Tray 1**: (up to 0.58 inch or 15 mm stack): 150 sheets of plain paper, 22 envelopes, 30 transparencies.
- **Tray 2**: (up to 0.98 inch or 25 mm stack): 250 sheets of plain paper.
- **Envelope slot**: one envelope.

### I/O interface
USB and LIO (either a IEEE 1284-compliant parallel connection or network connection model)

### Printer memory
8 MB built-in RAM

### Dimensions
**Without auto-duplex unit and Tray 2 installed:**
19.5 inches or 495 mm (width); 8.4 inches or 215 mm (height); 16.2 inches or 411 mm (depth)
**With auto-duplex unit and Tray 2 installed:**
19.5 inches or 495 mm (width); 11 inches or 278 mm (height); 18 inches or 456 mm (depth)

### Weight
- **Printer**: 14.330 lb (6.5 kilograms)
- **Auto-duplex unit**: 2.205 lb (1 kilograms)
- **Tray 2**: 4.409 lb (2 kilograms)

### Duty cycle
Up to 6,250 pages per month

### Power requirements
**Input**: 100–240 V AC, 1400 mA 50/60 Hz  
**Output**: 32 V DC, 2200 mA

### Power consumption
80 watts maximum
### Operating environment
- **Operating temperature:** 50 to 99 degrees F (10 to 35 degrees C)
- **Storage temperature:** -40 to 158 degrees F (-40 to 70 degrees C)
- **Relative humidity:** 20 to 80 percent RH non-condensing
- **Noise levels per ISO 9296:** Sound power LwAD: 61 dB; Sound pressure LpAm: 51 dB

### System requirements
**Minimum**
- Windows 98: Pentium 90 MHz, 16 MB RAM, 60 MB hard disk space
- Windows NT 4.0: Service pack 6 or later, Pentium 100 MHz, 32 MB RAM, 60 MB hard disk space
- Windows Me: Pentium 150 MHz, 32 MB RAM, 60 MB hard disk space
- Windows 2000: Pentium 300 MHz, 64 MB RAM, 60 MB hard disk space
- Windows XP, 32 bit: Pentium 233 MHz, 64 MB RAM, 60 MB hard disk space
- Mac OS 8.6 or later: 333 MHz (iMac) or 350 MHz (Power Mac G3 or later), 32 MB RAM
- To view the CHM file (Windows), you must be running Internet Explorer 4.0 or later.

**Recommended**
- Windows 98, Windows Me: Pentium 266 MHz, 32 MB RAM, 100 MB hard disk space
- Windows NT 4.0: Service pack 6 or later, Pentium 266 MHz, 64 MB RAM, 100 MB hard disk space
- Windows 2000: Pentium 300 MHz, 64 MB RAM, 100 MB hard disk space
- Windows XP, 32 bit: Pentium 300 MHz, 128 MB RAM, 100 MB hard disk space
- Mac OS 8.6 or later: 333 MHz (iMac) or 350 MHz (Power Mac G3 or later), 64 MB RAM
- To view the CHM file (Windows), you must be running Internet Explorer 4.0 or later.

### Product certifications
**Safety certifications:** CCC S&E (China), CSA (Canada), PSB (Singapore), UL (USA), NOM-NYCE (Mexico), NEMKO-GS (Germany), K Mark (Korea), CE (European Union), B Mark (Poland), IRAM (Argentina)

**EMC Certifications:** FCC Title 47 CFR Part 15 Class B (USA), CTICK (Australia and New Zealand), MIC Mark (Korea), CE (European Union), BSMI (Taiwan), GOST (Russia), ICES (Canada)
FCC statement

The U.S. Federal Communications Commission (in 47 cfr 15.105) has specified that the following notices be brought to the attention of users of this product.

This device complies with part 15 of the FCC rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Shielded cables

Use of a shielded data cable is required to comply with the Class B limits of Part 15 of the FCC Rules.

Pursuant to Part 15.21 of the FCC Rules, any changes or modifications to this equipment not expressly approved by the Hewlett-Packard Company, may cause harmful interference and void the FCC authorization to operate this equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.
EMI statement (Korea)

사용자 안내문 (B 급기기)

이 기기는 비업무용으로 전자파 장해를 받은 기기로서, 주거지역에서는 물론 모든 지역에서 사용할 수 있습니다.

Regulatory model number

For regulatory identification purposes, your product is assigned a Regulatory Model Number. The Regulatory Model Number for your product is **SNPRC-0302**. The regulatory number should not be confused with the product name (HP Business Inkjet 1100) or product number (C8124A or C8135A).

Power cord statement

The power cord cannot be repaired. If it is defective, it should be discarded or returned to the supplier.

LED classification

CLASS 1 LED PRODUCT
LED KLASSE 1
APPARECCHIO LED DI CLASSE 1
PRODUCT CLASY 1 Z DIODAMI (EWHECYCMILED)
Appareil à Diode Electriuminescente de Classe 1
ZARIZENI LED TRIY 1
KLASS 1 LED APPARAT
LUOKAN 1 LED

Energy consumption

Energy Star is a US registered service mark of United States Environmental Protection Agency.
DECLARATION OF CONFORMITY
according to ISO/IEC Guide 22 and EN 45014

Manufacturer’s Name: Hewlett-Packard Singapore (Pte) Ltd
Manufacturer’s Address: Imaging & Printing Manufacturing Operations
20 Gul Way, Singapore 629196

declares, that the product

Product Name: HP Business Inkjet 1100D
HP Business Inkjet 1100DTN

Model Number: C8124A
C8135A

Regulatory Model Number: SNPRC-0302

Product Accessory Number: C8247A HP Auto Duplexer
C8236A 250 sheets 2nd Paper Tray

Product Options: All

conforms to the following Product Specifications:


EMC: CISPR 22: 1997 / EN 55022: 1998 Class B excepting clause 9.5 which was not applied
IEC 61000-3-2: 1995 +A14 / EN 61000-3-2: 1995 +A14
FCC Title 47 CFR, Part 15 Class B / VCCI-2

Supplementary Information:


(2) The product was tested in a typical configuration with Hewlett Packard personal computer systems.

(3) This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Singapore, 13th March 2003
Chan Kum Yew, Director of Quality

• Australia Contact: Product Regulations Manager, Hewlett-Packard Australia Ltd, 31-41 Joseph Street, Blackburn, Victoria 3130, Australia
• European Contact: Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department, HQ-TRE / Standards Europe, Herrenberger Strasse 140, D-71034 Boblingen (FAX: +49-7031-14-3143)
• USA Contact: Corporate Product Regulations Manager, Hewlett-Packard Company, 3000 Hanover Street, Palo Alto, CA 94304 (Phone: 415-857-1501)

ENWW
Glossary

**Booklet printing**
This option enables you to print two pages onto a single, larger sheet of paper and reorder the page sequencing so that the page numbers are sequential when you fold the paper in half to form a booklet. For more information, see the printer driver Help.

**connection slot**
The connection slot in the printer holds one of the following (you cannot connect both at the same time):
- HP Jetdirect print server for networking (included with the HP Business Inkjet 1100dtn)
- parallel connector (optional for North America; included for the rest of the world in the HP Business Inkjet 1100d)

The HP Jetdirect print server is an LIO print server—a type of print server intended for printers that will be used in small groups of workers. The print server includes an embedded Web server to report the print server status, and it is compatible with HP Web Jetadmin.

**Flip pages up**
This option allows you to choose the orientation of duplexed pages. When you choose an option, view its icon in the printer driver to see how the page will look if you choose that option. For more information, see the printer driver Help.

**HP PhotoREt Color Layering technology**
This technology uses small, precisely placed drops of ink that visually blend together to create rich colors, smooth gradations, and cleanly defined color boundaries. This type of technology works with the printer resolution to deliver superb results without creating large file sizes and without slowing down printing.

**ink cartridges**
Ink cartridges hold the ink used for printing. Each color ink cartridge must be inserted firmly into its color-coded slot in order for the printer to work. Ink cartridges work with “printheads”.

**parallel port connector**
A piece of hardware that is connected to the printer that allows you to connect a printer directly to a Windows computer using a parallel cable. It plugs into the connection slot on the printer.

**PCL 3 driver**
Printer command language. A type of printer driver that processes print jobs using the processor and memory in the printer. It provides an efficient way for applications to control a wide range of printer features and is designed to translate application output quickly into high-quality raster print images. The 3 in PCL 3 identifies the version of the printer driver.
**print server or print server card**

A print server or print server card is a piece of hardware that can be connected to a printer (or other device), either internally or externally. The print server allows the printer to communicate with the computers on a network. This type of print server should not be confused with a computer acting as a server, or print server. The computer acting as a print server runs the software that the printer needs to operate.

**printer driver**

A printer driver (or PPD on a Macintosh) is the software on a computer that allows the computer to communicate with the printer. Use the printer driver to set printing options, such as setting the type of paper you are using or selecting the print quality.

**printheads**

Printheads transfer ink from ink cartridges onto the paper or other print media. There is one printhead for each color of ink cartridge. Each printhead must be inserted firmly into its color-coded slot in order for the printer to work. Printheads work with "ink cartridges".

**Quick Sets**

Quick Sets allow you to save the current printer driver settings (such as page orientation, print on both sides, paper source) for reuse. Quick sets can be selected and saved from most tabs in the printer driver. They are useful for projects that you print often that need the same settings each time. For more information, see the printer driver Help.

**resolution**

Resolution is a measure of the quality of the image you are printing. In HP printers, the resolution and printing technologies work together to produce superb results that resolution alone cannot offer.
index

Numerics
250-sheet tray. See tray 2

A
accessories
ordering online 3-3, A-1
part numbers A-1
warranty B-3
ADI AutoCAD drivers 1-17
administrator guide for HP Jetdirect print server 1-1
Adobe PostScript 3 software RIP C-1
aligning printheads 3-2, 4-7
Apple Macintosh. See Macintosh
Auto Select for trays 2-8
AutoCAD drivers 1-17
auto-duplex unit
capacity 2-3
clearing jams 4-11
dimensions C-1
illustration 1-5
media types supported 2-3
minimum margins 2-4
using 2-12
weight specifications 2-3, C-1
automatic duplexing 2-13

B
banners
HP Banner Paper A-4
sizes supported 2-2
trays supporting 2-2
Best mode
print speed C-1
recommendation for documents that use a lot of ink 4-20
recommendation for photographs 2-15
recommendation for transparencies 2-18
black and white pages, troubleshooting 4-20
blank pages, troubleshooting 4-17
bleeding colors, troubleshooting 4-21
blinking
color indicator light 5-4
ink cartridge light 5-3, 5-4
power light 5-1, 5-2, 5-4
printhead light 5-4
resume light 5-2, 5-3, 5-4
both sides, printing on. See auto-duplex unit; duplexing
Bright White Inkjet Paper, HP A-2
Brochure and Flyer Paper, HP A-3
buttons on control panel 1-4
buying supplies an accessories online 3-3
buying supplies and accessories online 3-3, A-1

C
cables
connections 1-5
Ethernet network 1-14
parallel connection (Windows) 1-6
part numbers A-1
regulatory compliance D-1
troubleshooting 4-13
USB connection (Mac OS) 1-10
USB connection (Windows) 1-6
calibrating
color 3-2, 4-10
printer 3-5
cancel button 1-4, 2-12
cancelling print jobs 2-12
capacities
input trays 2-3
output tray 4-22, 4-23
trays 2-3
cards
HP Photo Greeting Cards A-4
HP Textured Greeting Cards A-4
printing 2-16
sizes supported 2-2
tray capacities 2-3
trays supporting 2-2
cardstock
HP Premium Heavyweight Inkjet Paper A-3
sizes supported 2-2
cartridges. See ink cartridges 1-17
CD, Starter 1-1
certifications for safety C-2
changed printheads 4-3
checking status of printheads 4-3
CHM file, requirements for viewing C-2
cleaning printheads 3-2, 3-5, 4-3, 4-5
clearing jams 4-11
clear-cut pages, troubleshooting 4-17
color
calibrating 3-2, 4-10
recommendation for printing mode 4-20
resolution in dpi C-1
troubleshooting problems 4-20, 4-21
ColorFast Photo Paper, HP A-3
configuration page, printing for print server 4-14
configurations for printer 1-2
configuring trays 2-7
connections
Ethernet 1-14
Fast Ethernet A-2
illustration 1-5
interfaces A-2
network 1-12
parallel 1-6
print servers 1-5
remote peripheral 3-6
USB (Mac OS) 1-10
USB (Windows) 1-6
wireless Ethernet A-2
connectivity 1-2, 1-6
consumption, power C-1, D-2
control panel
illustration 1-3
parts 1-4
covers
printer supplies 1-3
top 1-3
custom-size media
printing 2-19
sizes supported 2-2
trays supporting 2-2
customer support. See support
Customization Utility 1-17
cut-off pages, troubleshooting 4-17
D
declaration of conformity
defaults
printer driver 2-10
trays 2-8
demo page, printing 3-2
deskjet control panel (DJCP) 3-6
diagnostic page, printing 4-14
diagnostic tools 3-1
digital photographs, printing 2-15
dimensions
auto-duplex unit C-1
printer C-1
direct connection 1-6
disks, copying software to 1-17
display. See control panel
DJCP (deskjet control panel) 3-6
documentation 1-1
dots per inch (dpi) 1-2, C-1
double-sided printing. See auto-duplex unit; duplexing
dpi (dots per inch) 1-2, C-1
Draft mode
print speed C-1
recommendations 4-20
drivers. See printer drivers
duplexer. See auto-duplex unit
duplexing
automatic 2-13
description and guidelines 2-12
manual 2-14
duty cycle C-1

E
EMC certification C-2
EMI statement (Korea) D-2
energy consumption C-1, D-2
Energy Star D-2
envelope slot
capacity 2-3, C-1
clearing jams 4-11
illustration 1-3
troubleshooting feeding problems 4-22
envelopes
printing 2-16
sizes supported 2-2
trays supporting 2-2
environmental specifications C-2
Ethernet network connection 1-14
Everyday Photo Paper, HP A-3
extending output tray 4-22, 4-23

F
faded output 4-20
Fast Ethernet connection A-2
Fast Normal mode
print speed C-1
recommendations 4-20
FCC statement D-1
feeding problems
envelope slot 4-22
jams 4-11
tray 1 or tray 2 4-22
film transparencies. See transparencies
firmware updates, notification 3-3
firmware version, locating 3-2
floppy disks, copying software to 1-17
Flyer Paper, HP A-3
fonts included with printer C-1

G
garbled text 4-19
garbled text 4-19
getting started guide 1-1
glossy papers, HP A-3
graphics, troubleshooting 4-19, 4-20
greeting cards
HP papers A-4
printing 2-16
tray capacities 2-3
guides on printer for paper 1-3

H
help
online 1-1
Toolbox 3-1
See also support; troubleshooting
HP auto-duplex unit. See auto-duplex unit
HP Banner Paper A-4
HP Bright White Inkjet Paper A-2
HP Brochure and Flyer Paper A-3
HP ColorFast Photo Paper A-3
HP Everyday Photo Paper A-3
HP Inkjet Utility
calibrating color from 4-10
description 1-1
using 3-5
hp instant support
description B-1
opening website 3-2
using 3-3
HP Iron-on T-shirt Transfers A-4
HP Jetdirect print servers
administrator guide 1-1
connection slot 1-5
installing 1-12
part numbers A-2
printing configuration page 4-14
setup documentation 1-1
HP Matte Greeting Cards A-4
HP PCL 3 printer driver 2-9, C-1
HP Photo Greeting Cards A-4
HP Photo Paper A-3
HP Photo Quality Inkjet Paper A-3
HP Premium Inkjet Paper A-3
HP Premium Inkjet Transparency Film A-4
HP Premium Paper A-3
HP Premium Photo Paper A-3
HP Premium Plus Inkjet Transparency Film A-4
HP Premium Plus Photo Paper A-2
HP Premium Transparency Film 2-18
HP shopping website A-1
HP Textured Greeting Cards A-4
HP Web Jetadmin 3-6
humidity specifications C-2

I
I/O interfaces C-2
image quality, troubleshooting 4-19
index cards. See cards
INF files 1-9, 1-14
Information tab, Toolbox 3-2
ink cartridges
checking ink level 4-1
illustration 1-4
light patterns on control panel 5-3, 5-4
non-HP 5-3
part numbers A-2
replacing 4-1
status 1-1, 3-1, 3-4
status light 1-4

I-2
troubleshooting 4-20
warranty B-3
Ink Level Information window 3-1
ink smears 4-20
inkjet paper, HP A-2
Inkjet Utility, HP
calibrating color from 4-10
description 1-1
using 3-5
input trays
capacities 2-3
clearing jams 4-11
duplexing from 2-12
feeding problems 4-22
inserting, troubleshooting 4-22
loading media 2-5
locking 2-8, 3-5
part numbers A-1
printing cards and envelopes 2-17
printing custom-size media 2-19
printing envelopes 2-17
selecting 2-7
selecting default 2-8
installing
documentation for 1-1
HP Jetdirect print servers 1-12
networked peripherals remotely 3-6
other software 1-17
printer drivers 1-13
software (hardware before software procedure) 1-8
software (software before hardware procedure) 1-7
Toolbox 1-1
interfaces
Ethernet 1-14
Fast Ethernet A-2
I/O C-1
LiO A-2, C-1
network A-2
part numbers A-2
wireless Ethernet A-2
Iron-on T-shirt Transfers, HP A-4

J
jams
clearing 4-11
preventing 4-12
Jetdirect print servers
administrator guide 1-1
connection slot 1-5
installing 1-12
part numbers A-2
printing configuration page 4-14
setup documentation 1-1
jobs
cancelling 1-4, 2-12
resuming 1-4
K
Korean EMI statement D-2
L
languages, printer C-1
latch for printheads 1-4
LCD panel. See control panel
LED classification statement D-2
LEDs. See lights on control panel
letterhead
duplexing 2-12
locking tray for 2-8
lights on control panel
description of patterns 5-1
illustration and description 1-4
limited warranty statement B-3
Linux printer drivers 1-17
LiO interface A-2, C-1
loading
custom-size media 2-19
envelopes in tray 1 2-17
media 2-5
local printing 1-6
locking trays 2-8, 3-5
low ink cartridges 4-1

M
Macintosh
cancelling printing 2-12
changing settings 2-11
connecting using Ethernet network cable 1-14
connecting using USB cable 1-10
system requirements C-2
uninstalling printing system software 1-15
main paper tray. See tray 1
manual duplexing 2-14
manuals 1-1
margins, minimum 2-4
Matte Greeting Cards, HP A-4
media
average quantity used per month by type 3-4
cardstock 2-2
clearing jams 4-11
custom-size 2-19
duplexing 2-12
envelopes 2-2, 2-16
HP part numbers A-2
loading 2-5
locking trays 2-8, 3-5
minimum margins 2-4
recommended weights C-1
sizes supported C-1
special 2-16
specifications 2-1
transparencies 2-18
tray capacities 2-3
types supported C-1
memory included with printer C-1
Microsoft Windows. See Windows
minimum margins for media 2-4
missing pages, troubleshooting 4-17
models of printer
description 1-2
location of information about 3-2
modified printheads 4-3
monitoring status remotely 3-6
monthly duty cycle C-1
MS. See Microsoft
myPrintMileage
description 3-4
enabling and disabling 3-4
network printing 1-6
networks
  connecting to 1-12
  documentation 1-1
  Ethernet connection 1-14
  Fast Ethernet connection A-2
  installing peripherals remotely 3-6
  interfaces A-2
  parallel connection 1-6
  printer connectivity 1-2
  printing information 3-2
  sharing printer 1-14
  wireless Ethernet connection A-2
noise specifications C-2
non-HP ink cartridges 5-3
Normal mode
  print speed C-1
  recommendations 4-20
not responding, troubleshooting 4-15
notifications
  printer driver and firmware updates 3-3
  warranty expiration 3-3

online help
  sources 1-1
  Toolbox 3-1
online purchasing 3-3, A-1
operating environment specifications C-2
operating systems
  documentation 1-1
  system requirements C-2
options. See settings
ordering supplies and accessories online 3-3, A-1
out of ink in cartridges 4-1
output quality, troubleshooting 4-19
output tray
  clearing jams 4-11
  illustration 1-3
  troubleshooting 4-22, 4-23
overhead transparencies. See transparencies
overheating of printer 4-15
overview of printer 1-2

pages per minute (ppm) 1-2, C-1
pages per month C-1
paper
  average quantity used per month by type 3-4
  clearing jams 4-11
  custom-size 2-19
  duplexing 2-12
  HP part numbers A-2
  loading 2-5
  locking trays 2-8, 3-5
  minimum margins 2-4
  recommended weights C-1
  sizes supported C-1
  special 2-16
  specifications 2-1
  tray capacities 2-3
  types supported C-1
paper guides on printer 1-3
paper output tray. See output tray
paper stack indicator 1-3
paper trays. See tray 1; tray 2; tray, output; trays; trays, input
parallel connection A-2
parallel cable part numbers A-1
parallel port
  connecting to 1-5, 1-6
  troubleshooting 4-17
part numbers
  accessories A-1
  interfaces A-2
  supplies A-2
parts
  control panel 1-4
  printer 1-3
  PCL 3 printer driver 2-9, C-1
  PCL languages included with printer C-1
  phone support. See support
  Photo Greeting Cards, HP A-4
  Photo Paper, HP A-2, A-3
  Photo Quality Inkjet Paper, HP A-3
  photographs, printing 2-15
ports
  location 1-5
  parallel 1-6
  settings 4-16
  troubleshooting 4-17
  USB 1-6
PostScript 3 software RIP C-1
power
  consumption C-1, D-2
  input connection 1-5
  light and button 1-4
  light patterns on control panel 5-1, 5-4
  requirements C-1
  troubleshooting 4-15
power cord statement D-2
ppm (pages per minute) 1-2, C-1
Premium Inkjet Paper, HP A-3
Premium Inkjet Transparency Film A-4
Premium Paper, PH A-3
premium papers, HP A-2
Premium Photo Paper, HP A-3
Premium Plus Inkjet Transparency Film, HP A-4
Premium Plus Photo Paper, HP A-2
print cartridges. See ink cartridges
print jobs
  cancelling 1-4, 2-12
  resuming 1-4
print media. See media
print quality, troubleshooting 4-19
print servers, HP Jetdirect
  administrator guide 1-1
  connection slot 1-5
  installing 1-12
  part numbers A-2
  printing configuration page 4-14
  setup documentation 1-1
print speed
  by model 1-2
  by print mode C-1
  slow, troubleshooting 4-16
printers, HP Jetdirect administrator guide 1-1
  connection slot 1-5
  installing 1-12
  part numbers A-2
  printing configuration page 4-14
  setup documentation 1-1
printer drivers
  AutoCAD 1-17
  checking for updated 3-2
  copying 1-17
  firmware update notification 3-3
  installing 1-13
  Linux 1-17
  PCL 3 2-9, C-1
  settings 2-10
  system requirements C-2
  warranty B-3
printer languages C-1
Printer Services tab, Toolbox 3-2
printer specifications C-1
Printer Status tab, Toolbox 3-1
printheads
  aligning 3-2, 4-7
  checking status 4-3
  cleaning 3-2, 3-5, 4-3, 4-5
  illustration 1-4
  latch 1-4
  light patterns on control panel 5-2, 5-4
  part numbers A-2
  replacing 4-8
  status 1-1, 3-1
printing supplies
  area in printer 1-4
  cover 1-3
  lights 1-4
  ordering online 3-3, A-1
purchasing supplies and accessories online 3-3, A-1
Q
  quality, troubleshooting 4-19
R
  RAM included with printer C-1
  refilled ink cartridges 5-3
  registering printer 3-2
  regulatory information D-1
  regulatory model number D-2
  relative humidity specifications C-2
  release notes 1-1
  remote installation and management of peripherals 3-6
  replacing
    ink cartridges 4-1
    printheads 4-8
    supplies, part numbers for A-2
  requirements for installation C-2
  resolution in dpi C-1
  resume button 1-4
  resume light blinking 5-2, 5-3, 5-4
  illustration and description 1-4
S
  safety certifications C-2
  service identification number, locating 3-2
  service providers, obtaining information about 3-3
  settings
    changing for Macintosh 2-11
    changing for Windows 2-10
    description 2-10
  setup documentation
    HP Jetdirect print servers 1-1
    printer 1-1
  sharing printer
    Macintosh network 1-11
    Windows network 1-14
  shopping website A-1
  size specifications
    media 2-1
    printer C-1
  slow printing, troubleshooting 4-16
  software
    compatibility C-1
    copying 1-17
    installing other 1-17
    installing with hardware first, then software 1-8
    installing with software first, then hardware 1-7
    system requirements C-2
    uninstalling 1-15
    warranty B-3
special media
  duplexing 2-12
  locking trays 2-8
  printing on 2-16
  specifications
    media 2-1
    printer C-1
  speed of printer
    by model 1-2
    by print mode C-1
  slow, troubleshooting 4-16
  Starter CD 1-1
  status
    ink cartridges 3-4
    monitoring remotely 3-6
    printheads 4-3
    supplies 1-4, 3-1
    through myPrintMileage 3-4
    through Toolbox 3-1
  stopping print jobs 2-12
  storage specifications C-2
  supplies
    ordering online 3-3, A-1
    part numbers A-2
  support
    resources B-1
    telephone B-2
    websites 3-5, B-1
  system requirements C-2
T
  technical support. See support telephone support. See support temperature specifications C-2
  test page, printing 3-5
  text, troubleshooting 4-18, 4-20
  Textured Greeting Cards, HP A-4
  thick paper. See heavy media
  This picture shows the control panel with the Ink Cartridge light blinking, and one or more of the color indicator lights and the Resume light on. 5-3
  Toolbox
    aligning printheads from 4-7
    calibrating color from 4-10
    checking status of printheads from 4-3
    cleaning printheads from 4-3, 4-5
    Information tab 3-2
    installing 1-1
    myPrintMileage 3-4
    opening 3-1
    ordering supplies from A-1
    Printer Services tab 3-2
    Printer Status tab 3-1
    tools for diagnostics 3-1
    top cover 1-3
  transparencies
    HP Premium InkJet Transparency Film A-4
    printing 2-18
    tray capacities 2-3
  tray 1
    capacity 2-3, C-1
    clearing jams 4-11
    duplexing from 2-12
    feeding problems 4-22
    illustration 1-3
    inserting, troubleshooting 4-22
    loading media 2-5
    printing cards and cards 2-17
    printing custom-size media 2-19
    types of media supported 2-2
tray 2
capacity 2-3, C-1
clearing jams 4-11
duplexing from 2-12
feeding problems 4-22
illustration 1-3
inserting, troubleshooting 4-22
loading media 2-5
locking 2-8
part number A-1
printing custom-size media 2-19
types of media supported 2-2
weight specifications C-1

tray, output
clearing jams 4-11
illustration 1-3
troubleshooting 4-22, 4-23

trays
capacities 2-3, C-1
duplexing from 2-12
illustration 1-3
loading media 2-5
locking 2-8, 3-5
part numbers A-1
selecting 2-7
selecting default 2-8
types of media supported 2-2

trays, input
capacities 2-3
clearing jams 4-11
duplexing from 2-12
feeding problems 4-22
inserting, troubleshooting 4-22
loading media 2-5
locking 2-8, 3-5
part numbers A-1
printing cards and envelopes 2-17
printing custom-size media 2-19
selecting 2-7
selecting default 2-8

troubleshooting
basics 4-13
blank pages 4-17
cables 4-13
color problems 4-20
cut-off pages 4-17
feeding problems 4-22
ink smears 4-20
jams 4-11
layout 4-18
power 4-15
print quality 4-19
speed 4-16
trays 4-22

troubleshooting resources
configuration page for HP Jetdirect print server 4-14
demo page 3-2
diagnostic page 4-14
hp instant support 1-1, 3-2, 3-3
HP support 3-2
light patterns on control panel 5-1
list of common printing problems and instructions for solving 3-2
myPrint Mileage 3-4
print server configuration page 4-14
printer configuration page 4-14
Toolbox 1-1

T-shirt Transfers, HP Iron-on A-4
two-sided printing. See auto-duplex unit; duplexing
typefaces included with printer C-1

U
uninstalling printing system software 1-15
update notification for firmware 3-3
usage information
average quantity of media used per month by type 3-4
number of pages printed 3-4
supplies 3-4
through myPrint Mileage 3-4

USB
cable part number A-1
connection procedure (Mac OS) 1-10
connection procedure (Windows) 1-6
connector 1-5

V
vents on printer 4-15
version of firmware, locating 3-2
voltage requirements C-1

W
warranty
notification of expiration 3-3
statement B-3
Web Jetadmin, HP 3-6
websites
hp instant support 3-2
HP shopping A-1
HP Web Jetadmin 3-6
Linux driver 1-17
myPrintMileage 3-4
ordering A-1
printer information 1-1
printer usage information 3-2
supplies ordering A-1
support 3-5, B-1
weight specifications
auto-duplex unit 2-3, C-1
media C-1
media, by tray 2-3
printer C-1
Windows
cancelling printing 2-12
changing settings 2-10
installing printer driver 1-13
sharing printer on a network 1-14
system requirements C-2
uninstalling printing system software 1-15
USB connection 1-6
wireless Ethernet connection A-2